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One of the most popular questions I get is,
“Which distribution should I use?” The answer 
is similar to the one for the question, “Which car
should I buy?” That is, the right answer depends
on what you want to do with it. For example, 
a car with a manual transmission is always the
right answer for me, but it may not be the right
answer for someone else.

With that disclaimer out of the way, I recently
have been telling people an almost generic answer:
Kubuntu Dapper Drake. Why? Because it is easy to
install, easy to update, complete, reliable and
totally free, all the way down to being able to
get a CD or DVD mailed to you. That doesn’t
necessarily make it the best choice for everyone,
but it certainly has decreased the amount of free
consulting I have been doing.

In order to support my opinion, I do at least
need to know about the competition. All the
competition? Well, it would be nice, but that just
doesn’t fit into my life. There are lots of choices,
and unlike car models, they can change signifi-
cantly every few months. So, let’s wait for our
next Linux Smackdown issue for a broader analy-
sis. For the moment, I am going to take a brief

look at some of the free alternatives to my ongoing
Kubuntu Dapper Drake answer.

First, let’s take a quick look at Edgy Eft, the next
Kubuntu version. As I write this, there is a pre-
release available with the final release to be available
later in October 2006. Edgy has a very different mis-
sion than Dapper. Dapper was put together to be a
long-term stable release. There have been regular
updates to fix some minor nits, but all in all, it lives
up to its goal.

On the other hand, Edgy is designed to be on the
bleeding edge. While playing with it, I found some
things I wish I had on my stable system. For exam-
ple, boot-up time has been lowered significantly.
Even on my older IBM ThinkPad T23 system, the sys-
tem is up and running in less than a minute. The
down side is there are things that work on Dapper
on the same hardware but fail with Edgy.

Edgy has many more cute features. For example,
the first time users log in, they are prompted to cus-
tomize the KDE configuration. This includes lan-
guage selection, “system behavior” (offering you a
KDE, UNIX, Microsoft Windows or Apple Mac OS-
like environment), level of eye candy and theme.
This is particularly well done where each step offers
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explanations of what the various options mean.
We can hope the problems are addressed before the final

release is shipped. Some certainly will be. But, if your goal is a
solid computing platform rather than wanting to see what’s
new, I feel Dapper will remain the right answer for at least the
next six months. (I say six months because there is a new
Kubuntu release every six months.)

Another option is Open SUSE 10.1. Unlike Edgy, it is a con-
servative update to SUSE 10. It is easy to install, complete and
reliable like Dapper. I would not hesitate to recommend it for a
desktop. Note that I am writing this article on a SUSE 10 system,
and although I have OpenSUSE 10.1 on another system, I
haven’t bothered to upgrade this system. If anything, that is a
testimonial for how stable SUSE 10 is.

Just released is Mandriva 2007. Mandriva, formerly
Mandrake, has always been geared for the desktop user. In
terms of licensing, there are free and non-free options. I decided
to download the one-CD free version and give it a test drive. In
fact, it is still downloading right now via BitTorrent.

Another plus for Mandriva, if you happen to be in Latin
America, is that they have a partnership with HP. Various HP
computers are available in this market with Mandriva pre-
installed. This is not a new announcement and was based on
Mandriva 2006, but I expect 2007 will be available soon.

So, it is here, and I am installing. Mandriva One, the single-CD,

is similar to Kubuntu in that it is a live CD that then allows you
to install it on the hard disk. So far, it has irritated me by not
having a back button where it needed one and expecting me to
double-click on the install icon.

The install is done, and it just said, “please halt your
computer, remove the CD and reboot”. Um, why didn’t it
just do all that?

Okay, rebooting. It said, “press Esc for verbose mode”. I did.
It still says the same thing. But, it did come up, and it seems to
work. After a reasonable amount of playing, it appears as com-
plete as one CD can be and reliable. It properly configured my
wireless card and generally seems to run fine. Probably the
biggest difference between Kubuntu and even OpenSUSE and
Mandriva is that Mandriva has a lot more self-promotion.

Bottom line: once it is up and running it works fine.
Although this single-CD version is free, there are lots of “you
need to buy it” options. I don’t need to explain them, because if
you decide to install this version, you will be told all about them.

That’s the end of my homework for this month. What will I
tell people who ask which version of Linux they should install? I
will (still) tell them Kubuntu Dapper Drake. The main change in
my story is that if they ask, “What about SUSE 10.1 or Mandriva
2007?” I can tell them that they are also good options.�

Phil Hughes is Group Publisher for SSC Media Corp.
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WANTING TO SEE WHAT’S NEW, I FEEL DAPPER WILL REMAIN THE RIGHT
ANSWER FOR AT LEAST THE NEXT SIX MONTHS.
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FROM THE EDITOR 

The Perfect Gift for the Perfect Linuxer

I am having a great deal of trouble writing this piece.
For a number of reasons, I don’t buy gifts. Well, I do, but 
I make sure they are anonymous, and (shame on me) I don’t
do it very often. And now, here I am writing an introduction
to our “Holiday Gift” issue!

Anonymous or not, most people at some point in 
their lives have been at the stage when they asked them-
selves: what on earth am I going to buy for XYZ’s wed-
ding/anniversary/surprise present—especially considering
that XYZ loves Linux? Or, sometimes you might want to
find a gift for yourself—you might have some extra money
and decide to treat yourself with the best gadget, because
you received a bonus payment or suddenly found money in
your old trousers (yes, that happened to me).

What you need, in this case, is this issue of TUX, where we
talk about presents and gadgets that Linux users definitely
will love. Sean Carruthers (the resident Gadget Guy here) and
Jay Kruizenga compiled their own lists of favourites, and you
surely will get some inspiration or hints from their articles,
however much you plan to spend.

Mango is with us this month as well. She has recovered
from her September holiday, and I can guarantee that she’s
back, because I just had dinner with her and her boyfriend!

Mango talks about spam (the type you get in your inbox,
not the meaty one I served as a joke for dinner),
Thunderbird and computer security. She personally asked
me to confirm that she’s not a fictional character, as if there
were any need for that.

John Knight, who I also had as a guest for dinner a 
couple of days ago (but no, Mango wasn’t there), explains
in detail how to use Audacity to create your own music. I
hadn’t realised how powerful Audacity was until I read
John’s article. I am most impressed, and I must say his arti-
cle (as well as meeting him) made me want to write music.
Hopefully, listening to my early attempts won’t become a
requirement to buying a TUX subscription.

For those TUX readers wearing a (possibly homemade)
suit, this month we have two articles that will certainly be
interesting for you: Phil Hughes talks about KMyMoney and
Planner to make sure that your finances are well kept and
your projects are well planned. They are simple programs,
but I am sure many of you will find them interesting.

Because installing software always has been one of the
most-discussed issues in Linux, we thought we would clear
it up and talk about Adept, which makes software installa-
tion a breeze. As Phil explains in the article, all you have to

Buying Linux gifts, the fun way.

TONY MOBILY
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do is pick the piece of software you want, and voilà, every-
thing is ready to run. I am sure we will refer to this article in
the future.

Dmitri Popov talks about Krusader, a file manager for the
power user with very interesting features. Lazy Linux users
simply use the file manager that comes with their desktops.
Krusader is the next step. Once you start using it, you’ll
wonder how you managed your files without it!

On a completely different note, this month Phil Thane
explains how to set up a file server from start to finish, 
without ever touching the command line. I personally feel
that this article is evidence Linux has gone really far. It’s
finally possible—and, in fact, easy—to carry out tasks that
up until two or three years ago would have given any sys-
tem administrator countless headaches. I am tempted to 
set up a file server myself!

And, if you get stuck, you always can set up a Qunu
account and get real-time help from an expert. When Matija
Suklje offered to write an article about Qunu, I was a little
sceptical. Then I used it and realised its potential. If Qunu
goes as far as it ought to, it will be a great support opportu-
nity for the Linux newbie!

If you feel like a bit of fun, different from boring, bi-
dimensional programs, jump right to the end of the maga-
zine and read Colin McGregor’s article on Quake 4. In the
olden days, video games were used as stress relievers. Quake
4 might not satisfy your stress-relieving goals, but it’s defi-
nitely fun to play!

I hope you enjoy this issue of TUX as much as I enjoyed
working on it. As always, comments and suggestions are
most welcome.�

Tony Mobily (BSc) is a computer consultant, journalist and Zen Buddhist. He lives
in Australia working as a magazine editor and consultant. Tony has been an
active member of the Open Source movement for many years. In 2004, he
founded Free Software Magazine, a popular publication about free and open-
source software. He is also the author of the book Hardening Apache and sever-
al articles about Linux and open-source software.
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Fedora and ipw2100: a Solution
A question was brought up to Mango, in the August 2006
issue, from Cliff about Fedora Linux and the ipw2100 wireless
card driver.

Fedora doesn’t include firmware for the ipw* series of drivers
in the distribution. I’m not an expert on license restrictions,
but for some reason, Ubuntu does include this firmware.

This site is where you grab the firmware: 
http://ipw2100.sourceforge.net/firmware.php

On Fedora, you can check whether the driver loaded by run-
ning:

su -c 'dmesg | grep ipw'

Or, on K/Ubuntu, type:

sudo dmesg | grep ipw

You will get a message about not finding the firmware if that
is indeed the problem. Once you download the firmware, sim-
ply put all the files included in the archive into /lib/firmware.

Then you can reboot or use the command rmmod ipw2100 &&
modprobe ipw2100 (or 2200 if you have the slightly newer
card) to reload the module. You can run dmesg again to see if
it found the firmware.

In Fedora, once you have the card installed, enable the
NetworkManager service by going to the Services option
inside the Administration options menu (if you are using
GNOME), and select both NetworkManager startup scripts.
This enables a systray applet in GNOME that can handle
switching wireless access points and WPA.

Hopefully this helps. Mango offered a lot of help about mak-
ing sure the device was recognized, but nothing was men-
tioned about the firmware, which is most likely the problem.
My Fedora install found my card right away.
--
Chris

Linux and Hardware Support
I just read that you’re the new editor [Tony Mobily] for TUX
magazine. Congrats!

Recently, I started looking into buying a new mouse. Granted,
I’m pretty happy with your basic, corded two-button scroll-
wheel mouse (which works on every Linux distro I’ve ever
tried). However, I’d like to upgrade to something a little more
fancy, and what better way to spend that M$FT voucher I got
a while back when the state of Minnesota recently settled
with them (I got an $84 US credit out of the deal for software
and some specific types of hardware).

Anyway, I’ve been looking at Logitech’s products, and from
what I can determine, they do not have or support Linux for

LETTERS
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their products. And they do not intend to in the near future.

So, I’m writing to you hoping to bring an awareness to a
greater problem: we need more support from the major hard-
ware vendors out there for Linux! This is not a new problem,
and very likely it will take care of itself once desktop Linux
takes off, but I believe it’s a topic that’s worth revisiting.
Thanks for reading and looking forward to a Linux future!!!
--
Terrance L. Dreyer

Hardware manufacturers think only in terms of user base. If
enough people request something, they will satisfy that
request. To solve the “hardware problem”, we need to make
sure there are plenty of people out there using Linux as their
desktops. They will start to complain about hardware not
working, and if enough people complain, hardware vendors
will listen. The good news is that this is finally happening! In
this very issue, we cover several Linux-friendly devices.—Ed.

Activation? No Thanks.
I used Xandros until a few months ago, and after reading
about Xandros requiring activation, it is unlikely I will use it
again. I agree that in your reviews of distros it would be nice
to include important information, such as the fact that a dis-
tro requires activation in order to be used.

I am now using Debian, Linspire and Freespire, and one thing
I like about Linspire, Inc., is that they don’t try to think of
ways to make life more difficult for customers.
--
Pollywog

Accounting Software: Quasar Is Linux and GPL
I have just read the Letters section in the October 2006 issue
of your fantastic magazine, which I devour as soon as I can
get to download it each month. I could go on and on about
how great your mag is, but here’s the point.

I work for a collection of companies in South Africa, and
we’ve migrated from Win to Lin over the last couple of years.
Our companies are involved in retail and wholesale. We found
Quasar Accounting to be a super solution. Quasar accounting
is a full-featured accounting package with point-of-sale capa-
bility too. Linux Canada is the company that manufactures it,
and we’ve had great support and interaction with them
whenever we’ve been unsure about how to go about doing
something. Quasar runs server and client components, which
can be one and the same machine. It runs on your choice of
Red Hat, Fedora or SUSE and has Postgres/Firebird/Sybase as
your choice of database back ends. The clients can run on the
same distros as well as on WinXP (so it’s great for a
mixed/migrating environment).

I’m the IT tech guy and not an accountant, but our account-
ants are extremely happy with how it does the accounting.

Regarding scalability, we use Quasar Accounting via a VPN
connection spread across our country in about 30 locations,
and we have tested it as functional down to as low as
3KB/sec.

Oh, and did I mention is really easy to use and set up, with
comprehensive documentation?

P2P
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(Disclaimer: I do not work for Linux Canada, nor do I receive
any income/commission from them, I’m just really glad to use
a great product that runs natively on Linux.)

I hope this is helpful to Mr Lowrie and others who may be
searching for the same. Perhaps it might be worth considering
an article on it sometime. See http://www.linuxcanada.com
for more information.
--
Andrew

We will definitely review Quasar soon. Thanks for the hint!—
Ed.

Linux Hardware and No Linux Support?
I am pleased to say that I’ve now migrated totally to Linux for
my home computing, and even remote access to my work
computer network runs just fine on Linux, so I’m not missing
Windows at all. I’ve noticed recently, however, that some of
the gizmos I buy come with CDs designed to run only in
Windows. I can understand this, as Windows is still the most
common OS, but I have difficulty accepting this when the
devices themselves turn out to be running on an embedded
Linux.

I’m referring to my TomTom GO700 Satnav and my Sony
Ericsson W900i phone, both of which run on Linux but come
with Windows discs and not a mention of Linux in their infor-
mation. I find that when I plug these in to my USB socket, I
can see the contents of the device, and in the case of the

phone, I can interact with it in Linux without difficulty, mov-
ing music back and forth and so on, but when I try to update
information or add features to the Satnav, it is impossible
without resorting to Windows.

Is it just me, or is there a way of solving this? Or, are the pro-
ducers of devices that use embedded Linux ignoring the Linux
community?
--
Ian Brooksbank

I know exactly what you mean. It feels unbearably unfair; a
device that runs Linux ought to support Linux itself! However,
it’s a market-size issue. Not enough people have requested
Linux compatibility to the maker of Satnav. This is quickly
changing, and by publishing TUX magazine, we are making
sure it changes as quickly as possible.—Ed.

MyBooksPro for Accounting
Regarding the Letters section in the October 2006 issue of
TUX: please inform Peter E. Lowrie that there is at least one
full-featured, robust accounting package for Linux that proba-
bly will meet the needs of most of his clients. The application
is called MyBooksPro, and it is available from AppGen
(http://appgen.com). It is very reasonably priced and has both
Linux and Windows clients that install easily. Most spiffy is
that their multi-user license is based on number of simultane-
ous sessions and not the number of seats. Thus, a two-user
MyBooksPro license actually provides more accessibility than
the five-user Peachtree version we used previously.

P2P

9www.tuxmagazine.com

http://www.linuxcanada.com
http://appgen.com
http://www.tuxmagazine.com


I don’t recall how I came upon this application, but I think the
process began with a Google search for “General Ledger
accounting for Linux”, or something similar. It wasn’t very dif-
ficult and took very little time.
--
Doug Thompson

Thanks Doug! We talked about MyBooks in the May 2006
issue. I should have pointed that out myself.—Ed.

OCR Software for Linux?
I would like to thank everyone at TUX for a great magazine,
and I would also like to welcome you [Tony Mobily] to TUX;
you will not regret taking this post, and I look forward to
reading your column.

I was a Microsoft slave for about 16 years—until Mandriva
2006 came out. I was disappointed that I was not able to use
two products: a good OCR and a Bible study program called
E-Sword, until I came across a program called CrossOver. I
have been able to install E-Sword with a couple of hours com-
piling it. It runs very well, and no problems have been found.
On the other hand, for the OCR package, I have to have a
dual-boot system to use OmniPage 12. I have tried the Linux
products, but with the work that I do, “old books” does not
do a very good job—I can type faster. Is there anything that
you could do to move those in high places to supply Linux
users an OCR program that works well? (I tried CrossOver,
and I could not get it to install OmniPage 12.)

I’m looking forward to future TUX magazines. They have

taught me a lot. Even with things that are above my head, I
read about them and found that I have been able to under-
stand what people have shown or asked me.
--
Stephen Chaffer

I found the following programs, after a bit of Googling:

� Kooka: http://www.kde.org/apps/kooka

� Ocrad: http://www.gnu.org/software/ocrad/ocrad.html

� GOCR: http://jocr.sourceforge.net

� VueScan: http://www.hamrick.com

� Clara OCR: http://freshmeat.net/projects/claraocr

Kooka in particular is very promising.—Ed.

Microsoft Bashing and History
In the October 2006 issue, the Letters section included a let-
ter titled “A Whole Bunch of Observations” by Andrew
Hawkins. In it Andrew wrote, “First up, what is it with Linux
people who feel they have to bash Microsoft at every given
opportunity? Without a simple and easy-to-use operating sys-
tem, computers would not be as popular as they are today.
No matter what your feelings about the business models, pric-
ing strategies and so forth of Gates and Co., it’s hard to deny
that they have helped spread the use of computers. They may
not have gotten everything right, but without them, would
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we be as far along as we are today?” To which you replied,
“About this question: ’without them [Microsoft] would we be
as far along as we are today?’ Who knows? My gut feeling is
that without Microsoft we would be much, much further. But
nobody actually knows.”

I would like to echo your response in a whole-hearted way.
Andrew needs to understand that this is typical Microsoft-
speak, that it’s insidious and that it’s simply not correct. (I’m
not picking on Andrew personally; there are millions upon
millions of people in his former circumstance.)

The true facts are that Microsoft often makes outrageous
claims and—well, because they are Microsoft—everyone sim-
ply believes them and accepts the claims at face value. But, so
often the facts are presented in a distorted fashion, or they
are simply wrong.

I personally first heard the concept that “Microsoft helped
advance the computing use of the American people” in testi-
mony Bill Gates made to the US Congress. I think that was
about 1994—in other words, Windows 95 may have been out
but only just barely. Gates was referring to DOS! It is an unde-
niable fact that the computing public is better served by wide-
ly interoperable software, and a monopolistic operating sys-
tem is one way to accomplish that. But suppose for a minute
that Gates had not licensed MS-DOS to IBM and instead
Apple’s Macintosh became the monopolistic OS. Wouldn’t the
American public have been better served to achieve the wide-
spread level of usability and commonality that arrived by
about 1996 in, say, 1988? How can Microsoft claim that
delaying this widespread acceptance and usage of the person-

al computer by almost a decade was a positive service to
American society?

Naturally, another means of achieving wide interoperability is
by having software—both applications and systems soft-
ware—that mingle cooperatively. I believe the Open Source
movement is a better means of accomplishing this than any
profit-motivated cooperation.

But Andrew says, “Members of the Linux community should
be bigger than that”, and the editor replies “Windows-bash-
ing is undeniably happening, and that’s very normal when
there are two factions competing against each other!” This
time you are both right. Attend any football game between
arch-rival schools and observe what happens when factions
compete. Nevertheless, we ought to take the moral high
ground and be better than that. I suggest we Linux users
ought to wage a consistent campaign to right the record of
public opinion for all of the Andrews out there—this will
often involve disagreeing with “history” as Microsoft presents
it—but avoid Windows-bashing as much as possible. That’s
my $0.02’s worth.
--
Bill Cupp

Thank you for your kind, wise words Bill. They are definitely
worth more than just $0.02; I swear!—Ed.

Predicting the Role of Desktop Computing
Nit-picking: I’m an aging geek who writes a small, twice
monthly links-type e-zine (Don’s Patch on http://freelists.org),
a recent Linux convert and an avid reader of TUX.
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In a recent TUX Desktop Watch newsletter, you used the word
“prophetized” and, having grown up in a Southern Baptist
world, I’ve often heard the word “prophecized”, but accord-
ing to Merriam Webster, neither of those is a word. The clos-
est thing listed is prophesied, which would have worked, but
in your shoes I’d probably have looked at what I typed,
thought about it for a second, back-spaced over it and typed
“predicted” (grin).

Commentary: time and again when changes occurred in the
traditional way things were done, there have been conserva-
tive individuals who ranted and raved against the evils of
change. This is the traditional way of change, and the back-
ground noise provided by the nay-sayers helps call people’s
attention to the changes which are occurring, thus facilitating
implementation.

The implementation of Web 2.0 offers an enormous boon to
consumers in that they finally can be spared the expense of
the computer itself. The full power of computing will be read-
ily available from public libraries, Internet cafés, and new ven-
ues are certain to appear. For example, coin-operated com-
puter terminals will probably become common fixtures in con-
venience stores. Privacy is bound to become less of an issue,
because no matter how insistent the government is about
demanding its own private “back door” into computer sys-
tems, the ordinary consumer is entitled to privacy. If it’s not
currently a right guaranteed by the legal system, forcing the
issue can only make it so.

Nevertheless, I’m sitting here at a desk I made myself, typing
on the keyboard of my own computer, and that’s not an abili-
ty I’m prepared to give up any time soon. People didn’t stop

buying horses when the automobile was invented, nor stop
buying automobiles when the bus was invented.

As the lines between television, telephone, gaming console
and personal computer become ever more blurred, one thing
seems clear. Whether it continues to be called a desktop com-
puter or it evolves into something with an entirely different
name, I will continue to have a computer in my home that
belongs to me, and I suspect that most other consumers will
have one too.
--
Don Crowder

About the word...er “predicted”, you are absolutely right.
What else can I say? I get a little confused between US
spellings, UK spellings and Australian spellings—okay, I am
out of excuses. About having your “own” computer, what you
say is absolutely true. However, it’s also a matter of how
much you can do with your computer alone, without an
Internet connection. 
I will carefully avoid proph... predicting the future, but your
PC’s role, already diminished by the Internet, might shrink
more and more.—Ed.

Viewing IE Sites with Linux
Thank you for your magazine—I enjoy reading it every month.
For years I have attempted to switch from MS Windows to an
alternative operating system like Linux, because invariably my
Windows machines would get slower and slower and crash (I
hate that blue screen of death!)—not to mention all of the
security issues with Windows. I have never been able to
switch completely, because my work requires me to view
Internet Explorer-only Web sites. The ID and masking features
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in Opera, as well as the Firefox extension user agent switcher,
never seemed to work 100% on these sites. I seemed
doomed to using Windows forever—that is, until now.

I came across a wonderful open-source project called
IEs4linux that a young programmer in Brazil named Sergio
Lopes started. He wrote a script that automatically installs 
IE 6 as well as (optionally) IE 5.5 and IE 5.0, plus all ancillary
items needed to run IE on a Linux machine. The user must
have a valid MS license—in my case, my PC came with
Windows XP preinstalled, so since I installed Slackware 
Linux and no longer use the Windows XP, that license 
covers me. You run the script, answer four questions, 
and the entire install proceeds automatically—perfect 
for a newer Linux user like me. Since installing, I have 
been able to view and use all of these IE-only Web sites
without a hitch. The Web address for this project is
http://www.tatanka.com.br/ies4linux/page/Main_Page.

Now, if someone could tell me how to print from a Linux
machine to a printer that doesn’t have a Linux driver for it
(my color laser Okidata C5100), I’d shout about the virtues 
of Linux until I was blue in the face.
--
Ed

Although it’s great that you were able to view IE-only Web
sites, I am not a great fan of these solutions. Especially today,
with Firefox gaining more and more market share, Web sites
that work only with IE really shouldn’t exist. Webmasters should
receive countless complaints from thousands of users who can’t
view those idiotic Web sites. About printing, we are preparing 
an issue dedicated to the topic right now—stay tuned!—Ed.
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I am very happy this month. My
boyfriend Otaku made a friend named
Bob and that makes Otaku very happy.
Bob is very nice, but he is very old. I
think he is 40-years old or even more.
Bob is very smart for an old man. I like
that because I had a question last month
about modems, and I do not know any-
thing about modems. If I get more ques-
tions about old things like modems,
maybe Bob can help me answer them.
Bob does not use KDE, and he does not
use GNOME. He uses Xfce. I do not like
Xfce. That is okay. It is okay for Bob to
be wrong.

Bob is lonely. He is looking for a girl-
friend. I cannot help him. My best friend
Bunny does not have a boyfriend, but I
do not think it is good for Bob to have a
young girlfriend who talks about armadil-
los all the time. One of the only old girls I
know is my mom, and she is married to
my dad.

I got lots of good questions this
month—thank you very much. Please

send me more good questions!

Q Hi Mango, do you really look like
your picture? Also, it would be

appreciated if you could go through the
tools available to deal with spam. I have
heard of SpamAssassin and SpamCop,
along with the spam filters included
with products like Thunderbird. I’m also
familiar with the tool MailWasher.net
available for MS Windows. Is there a
similar program in Linux that can allow
you to look at e-mail headers on the
POP server before actually downloading
the message body? That would useful
for avoiding viruses and the like, and a
real time-saver on a dial-up network
connection. Incidentally, what’s the best
distro/method for getting a Winmodem
to work in Linux? By the way, any news
about another startup company like
BlueSecurity trying to deal with the
spam issue? Thanks.—Kevin Vollick

A Of course I look like my picture. It is
a picture of me. If it was a picture

of somebody else, I would not look like
my picture. I tell you one truth, I am not
a natural blonde, so that is not how I
always look. I have naturally blue hair.
But this is how I look now. I am much
prettier in person, but you cannot put
me in person in a magazine, so this is the
best TUX can do.

Spam filters are very complicated,
and I do not think you want a lesson
on how different filters work. I think
you want some advice. So, I will give
you advice.

I do not know how you have your
computer set up, so I will start with some
guesses. Here is something good to do.
Install these programs: spamassasin,
pyzor and razor. I do not know what
Linux you use, so I can’t tell you how to
install these. These programs may help
you. They may do nothing. It depends on
other programs you use.

Now, I give you better advice. 
You use Thunderbird, so install
Spamato4Thunderbird. This is a very

Mango’s take on fighting spam, configuring Thunderbird and security.
MANGO PARFAIT

Q&A with Mango Parfait
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good spam filter. This is better than the
spam filter that is in Thunderbird
already. You need to install Java to
make Spamato4Thunderbird work. I think
you should install the Java plugin for
Firefox too. I do not tell you how to install
Java and the plugin. You must learn that
for your Linux distribution.

Do you have Java and the Java plugin
installed? Good. Here is how to install
Spamato4Thunderbird. Click Tools→
Extensions on the main menu of
Thunderbird. You will see the extensions
window, as shown in Figure 1.

Click on the link Get More Extensions.
Your browser will go to a page for
extensions. Search for spamato, and 
go to the right extension page for
Spamato4Thunderbird. You will see 
a page with something like what you
see in Figure 2.

You can see instructions there, but I

say them here. Right-click on Install Now
and save the file. It is easy to save this file
to the desktop. Click on the Install button
in the window you see in Figure 1. Pick
the file you saved. It will end with .xpi.
Look at Figure 3 to see me install

Spamato from my desktop.
Now you see something like Figure 4.

You see Spamato4Thunderbird here? Very
good! Read the message. Spamato does
not work until you restart Thunderbird.

Exit Thunderbird and start Thunderbird
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Figure 1. Thunderbird Extensions Dialog

Figure 2. Spamato Installation Page
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again. You will wait for a few minutes,
and then you will see a pop-up window
like the one shown in Figure 5. Click the
Yes button.

Now you will get an e-mail from
Spamato, as shown in Figure 6. You
can click on the link in the e-mail to
get instructions, but you do not need
this. Now you add three icons to the
Thunderbird toolbar. Right-click on the
Thunderbird toolbar and click the
Customize... menu selection. This is easy
to find. There is no other menu selection!

You will see a window with buttons
you can put on the toolbar. Scroll or
make the window bigger to see three
icons for Spamato. You see a Spam but-
ton, a No Spam button and probably a
Loading... button. Drag these buttons to
the toolbar, one and then the next and

then the next. Maybe you want a space
first or maybe two spaces if you like this
better. You will see a toolbar like the pic-
ture in Figure 6.

Are you done? No. Now you select 
a spam e-mail and click on the Spam
button. Do the same select and click
the Spam button for every spam e-mail
you get. Never delete spam e-mails.
Always use the Spamato Spam button.
This teaches Spamato how to know
messages are spam. Spamato does not
recognize spam until you teach it a lot
of messages. After you teach it a lot 
of messages, it knows spam better
than any other spam filters I use. It 
is much better than the Junk filter 
in Thunderbird.

What does the third icon do? This
takes you to a Web page to look at
what Spamato is doing and to config-

ure Spamato. Click on the third icon
with bars. You should see a Firefox
page like the one shown in Figure 7.

This page is very empty! This is a
new installation, and Spamato did not
learn anything yet. I will let you play
with this page. There are many things
you can do.

Here is one important thing. When
Spamato starts to filter spam, it can
make a mistake and filter a good mes-
sage. It remembers the messages for
two weeks. Do you see the link on the
left called Filter History? Click this link.
It takes you to a list of messages that
have finished coming in. You can see
messages Spamato thinks are spam 
and messages Spamato thinks are
good. There are links you can click to
view a message that you do not know
about. There are buttons to tell
Spamato that a message is spam.
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Figure 3. Install Spamato from the File Dialog

Figure 4. Spamato4Thunderbird is
installed but not ready.

Figure 5. Spamato checks your e-mail
address.
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There are buttons to tell Spamato that a message it thinks
is spam is not spam. This is important. If you tell Spamato a
message is not spam, it does not put that message back into
an IMAP inbox. Do not be afraid that Spamato lost your mes-
sage. If you tell Spamato that a message is not spam, Spamato
puts the message in the Local Folders inbox. Look there to find
this message. You can move it to the IMAP inbox now if you
think this is okay.

Spamato sings a spam song when it finds a spam message.

You can change this sound if you do not like the song.
Keep using Spamato, and it will get better and better.
You ask me about BlueSecurity. There is a big controversy

about BlueSecurity, and I do not want to talk about that. I will
leave it for opinion columns. You know I do not tell people my
opinions about things like BlueSecurity or GNOME or other
things. I only answer questions.
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Figure 7. A Starting Spamato Configuration and Examination
Web Page

Figure 6. Thunderbird after you add Spamato icons to the toolbar.

SPAMATO SINGS A SPAM SONG
WHEN IT FINDS A SPAM MESSAGE.
YOU CAN CHANGE THIS SOUND IF
YOU DO NOT LIKE THE SONG.
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Q Seeing this month’s issue [October 2006] is on e-mail
and some articles on Thunderbird, I thought I would

see if you could answer this question. I have Linux on three
computers and am using Thunderbird on two of them (desk-
top and laptop). I have the same problem with both. When I
click on an HTML link in an e-mail, nothing happens. I have
read about different things to try, but none of them worked.

I am using Ubuntu Linux and have checked Preferred
Applications and made sure that my browser was set to
default firefox %s and my Mail Reader was set to mozilla-
thunderbird %s, which they are. I also looked through all the
settings, including the advanced settings but cannot find
anything to change that will make my links work.

I thought I would give you a try at this one, and hope-
fully you can come up with a answer for me. Thanks, and
keep up the good work in this column.—Irv

A Hi Irv. Mozilla Thunderbird does not look at your
default browser unless you tell it to look at your

default browser. I do not do that anyway. I always want
Thunderbird to start up Firefox or use an open Firefox
window. Do you want that? Here is what to do. Start
your favorite editor, like gedit, with sudo. Edit the file
/etc/mozilla-thunderbird/global-config.js, like this:

$ sudo gedit /etc/mozilla-thunderbird/global-config.js

Look for the first two lines that start with pref. Take out
the comments if there are comments. Change the last part
of the command to start up Firefox. Look at Listing 1. This is
the way my file looks. Thunderbird will use Firefox for links if
you make your file look like this.
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Listing 1. The /etc/mozilla-thunderbird/global-config.js File

// ************************************
// ***     GLOBAL CONFIG FILE       ***
// *** PUT YOUR GLOBAL CONFIGS HERE ***
// ************************************

/*
use this if you have no access to gnome configuration
as described on http://www.jwsdot.com/debian/faq.html#q9
and don't care about debian default settings.

*/
pref("network.protocol-handler.app.http","firefox");
pref("network.protocol-handler.app.https","firefox");

/*
uncomment this if you want your browser configured as
your default by means of the debian alternatives mechanism

*/
// pref("network.protocol-handler.app.http","x-www-browser");
// pref("network.protocol-handler.app.https","x-www-browser");

/*
use this to tune your gtk2 mouse feeling

*/
// pref("widget.gtk2.dnd.threshold",25);
// pref("widget.gtk2.double_click_timeout", 300);

/* enable locale packages */
pref("intl.locale.matchOS", true)

http://www.tuxmagazine.com
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Q Dear Mango, I’ve been using Linux
for about six years, but in some

ways, I’m still a newbie, because I am
always in a rush to get specific tasks done
and don’t have time to play with the sys-
tem as much as I would like. Thus, it has
taken more than a year for me finally to
get this e-mail written. I have three ques-
tions starting with a trivial one and mov-
ing up the food chain.

Your columns encouraged me finally to
switch from GNOME to KDE. I currently
use Kubuntu and love it. However, about
the same time, SUSE/Novell just switched
from KDE to GNOME. Any comments?

Internet security—just how vulnera-
ble are client computers if one doesn’t
open e-mails from strangers offering to
enlarge various body parts and such? A
friend of mine leaves his Windoze XP
box on all the time with a live broad-
band connection, no firewall, virus pro-
tection software not updated for
months and has had no noticeable
problems. I have likewise had no notice-
able problems with my Linux box,
though I can’t determine if Shorewall is
running or not (it is installed). Both of

us use the same model Linksys router
between our computers and the outside
world. It does NAT, but has only a rudi-
mentary firewall. If no servers are inten-
tionally installed (other than the X-serv-
er), are we still vulnerable? With one of
these cheap routers doing NAT, is there
a general rule as to which is more
secure, having it face the outside and
present non-routable addresses to an
internal firewall serving the internal net
or switching the positions of the fire-
wall and router? (What? You said you
didn’t have any servers! See below.)

I hope you also will entertain OpenBSD
questions. I have been trying to solve this
problem off and on for about six years
without any luck. Basically, I would like 
to set up a command-line-only OBSD 
box to act as an IP-less bridge to screen
incoming and outgoing traffic silently for
badness.—In/UnSecure in Un/Indiana

A What do I think about SUSE? I think
there are GNOME bosses and KDE

bosses. They have a fight, and the
GNOME bosses win. Maybe I am wrong.
Maybe SUSE is just stupid.

The Linksys router protects the
Windows computer and the Linux 
computer. If the Linksys router is not
too old, it does not let anyone on the
Internet change the settings. Your 
computers are safe if you do not
change the Linksys settings to let
Internet people get to your computers.
The Linux computer is more safe than
the Windows computer, because there
are many viruses and trojans for
Windows that you can get from e-mail
or Web sites. There are not many viruses
or trojans for Linux, and it is hard for 
a virus to break Linux if you run Linux
as a normal user.

I do not know what you mean about
entertaining OpenBSD questions. I will
dance for them, maybe? I do not answer
them. TUX is for desktop Linux people.
TUX is not for command-line BSD people.�

I am a sweet, humble, delicate and very cute
genius who is at your service to answer your
Linux questions. Send your questions to
mango@tuxmagazine.com. I am deeply sorry 
that I do not have time to respond to anyone
directly by e-mail, but I will select as many 
questions as I can and answer them here.
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YOUR COMPUTERS ARE SAFE IF YOU DO NOT CHANGE THE LINKSYS SETTINGS 
TO LET INTERNET PEOPLE GET TO YOUR COMPUTERS.
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Looking for a gift for the Linux fan in your life? It
can be a challenging task, but fear not—we’ve
put together a list of some of our favourite gadg-
ets that are Linux-friendly.

MEMOREX TRAVELDRIVE ID
http://www.memorex.com
$80 US

For the person who’s always carrying around a
ton of different USB Flash drives, it can be a chal-
lenge to keep them all straight. Which drive has
the work documents? Which one has the photos?

The TravelDrive ID solves that problem.
What it does: it stores up to one gigabyte of

data, but it has a built-in LCD “label” that lets
you identify it at a glance.

Why it’s soooo cool: although other USB

Flash drive are identifiable only if you place a
sticker on the side of them, the Memorex
TravelDrive ID has a small LCD window along one
side that shows you the drive’s volume name. If
you rename the drives on your computer, the win-
dow automatically updates to the new name.
Better yet, the LCD window also shows how
much of the drive’s memory is currently being
used, so you easily can tell which drive has
enough room for your files.

Who would love it: anyone who constantly
juggles multiple USB keys filled with different
types of data.

POWERSQUID SURGE3000 CALAMARI
http://www.powersquid.net
$80 US

There’s nothing worse than trying to plug in
your cell phone, MP3 player, cordless phone, DVD
player and all your other electronics gear, if all you
have is a standard power bar. Even if you have
enough plugs, chances are some of your gadgets
use an oversized power brick that covers up an
adjacent power outlet. What to do?

What it does: rather than lining up all the
outlets in a row, the PowerSquid breaks each of

the outlets onto six individual “tentacles”, so you
can accommodate a power brick of any size or
orientation. Additionally, the two middle outlets
have small LED lights, so you can locate them eas-
ily in the dark (for instance, if they’re tucked away
behind a home theatre setup). Plus, it protects
against surges and comes with a $500,000 US
connected equipment warranty.

Why it’s soooo cool: in addition to the indi-
vidual tentacles for plugging in your electronics,
the PowerSquid also features a flat-profile rotat-
ing connector at the end of the power cord

Gadgety Gift Guide
Presents a Linux lover definitely will love.
SEAN CARRUTHERS
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that plugs in to the wall, allowing it to be
plugged in to almost any outlet. And, of course,
it kind of looks like a squid. (It doesn’t shoot ink
at you, thankfully.)

Who would love it: people who are always
battling with their power bars to get everything
connected.

OLYMPUS EVOLT E-330
http://www.olympusamerica.com
$850 US and up (depending on configuration)

Although most digital cameras come bundled
with Windows-only software, the cameras them-
selves usually work just fine with Linux
machines—thanks to the fact that they are

designed to appear as a Mass Storage Class
device when connected to a computer. Simply
plug it in via USB, and it will show up as a remov-
able drive. The Evolt line is Olympus’ series of con-
sumer-level digital SLR cameras, and the E-330
adds the killer LiveView feature. If you already
have Olympus lenses, you can buy the E-330 body
by itself, but you also can buy it pre-bundled with
a variety of different lenses offered by Olympus.

What it does: the Evolt E-330 is a 7.5
megapixel digital SLR, which means high-resolu-
tion pictures, and it has the ability to use a grow-

ing number of lenses designed to be used with
the four-thirds system. Unlike with other manufac-
turers’ cameras, which are designed to accommo-
date lenses from the film era, the lenses for the
four-thirds system are designed from the ground
up to work with digital. This means lenses that are
smaller and lighter, so you won’t have such a load
on your shoulder when you carry a few lenses
with you.

Why it’s soooo cool: although digital SLRs all
have an LCD viewfinder on the back, most show
the photograph only after you’ve taken the pic-
ture. (With an SLR camera, the image coming in
through the lens hits a mirror and is redirected up
to the eyepiece; because the mirror is in the way,
nothing hits the imaging sensor until you press

the shutter button and the mirror slides out of the
way.) The Evolt E-330 was the first camera to use
the LiveMOS imaging sensor, which allows you to
preview the image on the LCD screen before you
actually press the shutter. The E-330 also allows
you to use the LCD to zoom right in on a smaller
section, so you have exactly the focus point
you want.

Who would love it: people who want to get
into the world of digital SLR photography, but
who aren’t already weighed down by a substantial
investment in older film-era lenses.

MAXTOR SHARED STORAGE II 1TB
http://www.maxtor.com
$800 US

It seems that no matter how much hard drive
space you have on your computer, it’s never
enough to go around. Worse, even if you have
enough hard drive space on one machine, sharing
your files with other computers around the house
can be a real chore, if you’re not ready to roll up
your sleeves and learn all of the ins and outs of
safely sharing your files. That’s where network-
attached storage devices really come in handy—
you simply plug them in to your home network,
and with a few quick configurations, you can gain
access to your shared files from any other com-
puter on your network, even when all your other
computers are switched off.

What it does: it has a full terabyte of storage
space—that’s 1,000GB of storage space. This
makes it a great choice if you want to set up a

shared media library or have a device on your net-
work that you can use to perform backups.
Although the software included works only with
Windows, Linux users easily can connect to it
using Samba—the way they would network with
any other computer.
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Why it’s soooo cool: c’mon, it’s a terabyte.
Admit it—that’s pretty cool. And, for those who
are more technically inclined, the Maxtor network-
attached storage devices have proven to be pretty
modder-friendly, with third-party firmware avail-
able for those who don’t really want to use the
pre-loaded Maxtor firmware.

Who would love it: people with a ton of files
to share, who don’t want to leave their noisy
computer running 24/7.

LOGITECH Z-5450 DIGITAL SPEAKERS
http://www.logitech.com
$499 US

Good sound is always a plus, especially when
you want to play back a DVD movie complete
with surround sound. Logitech has a number of
years’ experience in the world of multichannel
speaker setups. This is a completely digital speaker
set—and one that’s designed to hook into more
than only your PC.

What it does: a lot of speaker sets are little
more than speakers, subwoofer and a volume
control. This particular set features a breakout
box with connectors for a number of different
audio sources, including two optical connec-
tors, a digital coax connector, and multichannel

analogue (in the form of three 1/8-inch jacks,
like you’d find on a surround-capable sound-
card). The breakout box has a small LCD 
window that shows you your input source and
what surround mode you’re using. You also
can use the window to adjust your subwoofer,
centre channel and surround levels. And, for
those who don’t always want to rattle the
floorboards, there’s also a headphone jack on
the side of the breakout box.

Why it’s soooo cool: the sound is amazing—
it’s THX-certified, even! And, you can hook the
same set of speakers to your computer, your com-
ponent DVD player and your digital cable box.

Who would love it: people who want great
sound out of their computers and their other
home theatre equipment without having to set up
multiple surround speakers. It’s also a great choice
for those trying to fit all of their various multi-
media gear into a small space.

USER FRIENDLY BOOKS
http://www.oreillynet.com/pub/au/614
$13 US each

You’ve seen the User Friendly comic on-line at
http://userfriendly.org and in magazines like our
sister publication Linux Journal. But, you also can
get the adventures of the User Friendly gang in
paperback books that can be thumbed through
even when the Internet connection goes down.

What it does: not only does each book pro-
vide a few hours of entertainment, but the books
also help people better understand the wacky 
world of open source, coding and ISPs.

Why it’s soooo cool: ISP customer-support
hijinx, marketing mayhem, Windows put-downs,
distribution battles and a sentient dust puppy.
What more could you want?

Who would love it: people who love comic
strips but think there just isn’t enough Linux
talk in them.

SAMSUNG SYNCMASTER 244T MONITOR
http://www.samsung.com
$950 US

Desktop real estate is always at a premium—as
soon as you open up that Web browser, there’s
not much room to do anything else on the screen,
which means constant flipping back and forth
between applications or between virtual desktops.
For those who want to rock the desktop with a
bit more screen space, it’s hard to beat a monitor
this big.

What it does: it provides a whopping 1920 x
1200 pixels of desktop space, which is more than
enough to keep a number of applications open at
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the same time. It features the usual VGA and DVI
inputs for connecting up to your computer, but
there’s also a component connector for hooking
up directly to your DVD player—team it up with a
set of high-quality surround speakers (like the
Logitech speakers described above), and you’ve
got a killer mini-home theatre setup.

Why it’s soooo cool: the screen quality is
great, and you can cycle through the multiple
inputs to switch between Linux (on your PC) and
an episode or two of Battlestar Galactica (on your
component DVD player).

Who would love it: anyone who wants a
high-resolution computer screen that can double
as a compact high-definition multimedia monitor.

PARALLELS WORKSTATION (FOR WINDOWS/MAC)
http://www.parallels.com
$50 US (Windows) or $80 US (Mac)

If you know a Windows or Mac user who is

curious about Linux but isn’t quite ready to com-
mit an entire computer to explore the operating
system, you’re no longer stuck with a live CD. You
can help them get virtual instead!

What it does: instead of requiring a separate
partition to install a new operating system,
Parallels creates a virtual machine in the form of a
large file on your regular operating system’s parti-
tion. When you start up Parallels and that virtual
machine, it mounts the disk image found in that
large file and runs it in a separate memory space,
so that what happens in your virtual machine
doesn’t interact with your main operating system.
The good news about Parallels is that so long as
you have the hard drive space available, you can
install as many of these virtual machines as you
like. And, if you want to back up your virtual
machine, you simply need to make a copy of the
file that serves as your virtual machine. So, why
am I talking about this in a Linux magazine?
Because you can install pretty much any operating
system designed to run using an x86 processor,
including Windows 3.1 through Windows XP,
OS/2 and, yes, many different distributions of
Linux. There are presets for installing kernel 2.4

and 2.6, but there’s also a custom Linux setup
for versions of Linux that don’t quite work with
those settings.

Why it’s soooo cool: you get to run Linux on
your computer without having to overwrite your
current operating system. You don’t have worry
about messing up your machine while re-adjusting
partition sizes, and you can run two different
operating systems at the same time.

Who would love it: people who want to
explore the world of Linux but don’t want to (or
can’t, for business reasons perhaps) give up on
their old operating system.�

Sean Carruthers is a freelance technology
journalist from Toronto. He spent six years
at Canada Computer Paper, first as
Products Editor at The Computer and later
at HUB Digital Living magazine. As a free-
lancer, he has written for the Globe and
Mail, http://globetechnology.com, HUB

Digital Living, Computer Dealer News,
Homefront and CE-Biz. Although a relative newbie with Linux
(SUSE, thank you very much), he has extensive experience with
tech gadgets of all sorts and is enjoying figuring out which ones
are compatible with Linux.
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The Holidays are here again. It’s a great time of
year—a time for family and the exchange of gifts.
If you’re like me, you may sometimes find it diffi-
cult to shop for one or two members of your fam-
ily, because they already have everything they
could possibly need or want. Perhaps you don’t
have a clue what to get the Linux lover in your
family. Hopefully, this article gives you a few ideas.
I have listed the items mentioned here based on
price (high to low) knowing full well that most
people do not have the money to spend more
than $500 US on a single family member; there-
fore, I’ve included numerous gift ideas for a limit-
ed budget. All items mentioned in this article
would be appreciated by any Linux fan—it might
even be the best gift of the year! So, having
said this, let’s take a look at a few extra-great
TUX gift ideas.

LINUX-CERTIFIED LC2000 SERIES LAPTOP
http://www.linuxcertified.com/linux_laptops.html
Starting at $999 US (check on-line for special
sales)

Most laptop computers come with a Windows
tax added on, whether or not you choose to use
Windows. Linux-Certified laptop computers are

free of that tax.
With five LC2000 units from which to

choose, starting at $999 US, you have a great
selection of high-performance Linux laptop
computers. These laptops won the 2004 Linux
Journal Readers’ Choice Award as well as the
2005 TUX Readers’ Choice Award, so they
come highly recommended. The laptops come
pre-loaded with Ubuntu, SUSE Linux or you can
have it shipped free of any OS, so you can
install your favorite Linux flavor. The five avail-
able units are lightweight and powerful. There
is a laptop for just about everyone.

Who would love it: people who are in the
market for a quality Linux replacement for their
existing aging laptop or people who are looking
for their very first laptop computer.

IBEXPC INTEL OR AMD DUAL-CORE LINUX
DESKTOP SYSTEM
http://www.ibexpc.com/linuxsystems.html
Sale-priced at $549 US (Intel) or $649 (AMD) US

Browse your favorite computer store, and you
will find numerous Windows PCs fully loaded and
ready to go. So, where does an individual find a
good-quality Linux PC that packs a vault of

100%-TUX Presents
When having Linux installed is not enough.
JAY KRUIZENGA
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power? IBEXPC is one such manufacturer of well-supported Linux desktop
PCs that deliver power at an affordable price.

Although IBEX also carries less-expensive units, the two mentioned here
pack the most bang for the buck. They’re dual-core—meaning, they are fast.
The units come with 2.66MHz processors, 512MB memory upgradable to
4GB, 16x DVD player and 80GB hard drives (everything is upgradable). They
ship with no OS installed, with Ubuntu or with SUSE. IBEXPC is a five-star
Yahoo! Top Service Award Winner due to its top-quality, on-time and afford-
able custom-built systems—can’t go wrong here. One-year parts and labor
warranty included.

Who would love it: the Linux power user who demands a high-
performance desktop system.

CUTE AND CUDDLY PENGUIN IPOD/MP3 SOFT SPEAKERS
http://www.computergear.com/pen.html
$29.99 US

This is the perfect geeky gift for the Linux fan in your life—not available
anywhere else. Listen to your favorite tunes with these cute and cuddly
stuffed penguins.

Why it’s soooo cool: Inside each penguin is a built-in speaker and
amplifier. Simply plug the animals in to your iPod or MP3 player and listen
to/share your music anywhere. They’re powered either by a computer’s USB
port or two AA batteries.

Who would love it: the music lover in your life.

CUDDLY STUFFED TUX WITH TRAVEL MUG
http://www.computergear.com/tuxtravmugdo.html
$29.99 US sale-priced

Add a stainless-steel travel mug capable of holding 16 ounces of Java
to an 8" plush cuddly Tux doll and what do you get? A perfect combo.
This gift set is great for displaying one’s pride in Linux. No one can miss
the Tux doll, and every Linux user needs a travel mug embellished with
Larry Ewing’s Tux mascot.

Who would love it: kids of all ages and java lovers.

LINUX-BRANDED APPAREL AND MORE!
http://www.cafepress.com
Prices vary depending on article (from $3.49 to $25.99 US)

What do you get for that special someone who loves Linux but has every-
thing? You might be able to find an idea at CafePress. There’s so much to
choose from—more than 2,500 designs!

CafePress is an on-line marketplace where you can find numerous Linux
items not available anywhere else. There you will find clothing, such as golf
shirts, sweatshirts (hooded and unhooded), T-shirts (short- and long-sleeved),
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thongs, tank tops, infant creepers, toddler shirts, even dog shirts, caps/hats,
bags, posters, calendars, mugs, mousepads, wall clocks, stickers, magnets
and more! Each item comes in multiple styles and designs. You even can
design your own logo, upload it and have it printed for that special some-
one. How cool is that? Be certain to check out TUX magazine’s gear at
CafePress while you’re there (http://www.cafepress.com/tuxmagazine).

Who would love it: there is something for everyone at CafePress.
Simply type in “Linux”, and you will discover more than 2,500 Linux designs.
The clothing is good quality (from personal experience).

SUBSCRIPTION TO TUX MAGAZINE
http://www.tuxmagazine.com
$9.95 US

TUX is the perfect gift idea for every new-to-
intermediate Linux user. The benefits of a TUX
subscription are obvious—great articles for the newbie
Linux user with how-tos and reviews intended to inform the reader of the
latest and greatest of all things pertaining to
Linux. At only $9.95 US per year ($.83 per
month), TUX is a great value.

Who would love it: every new Linux user
with a fervent desire to learn more.

CUDDLY STUFFED TUX
http://www.thinkgeek.com/geektoys/plush/288e
$6.99 US

Here is the perfect inexpensive gift for every Linux lover. A plush Linux
mascot designed by Larry Ewing. Great for sitting atop or alongside a moni-
tor. They’re 6" tall and actual Adelie penguins.

Who would love it: kids of all ages.�

Jay Kruizenga, a former Marine, is an accomplished Marketer (specialty:
E-Commerce), business owner and aspiring author. He has a deep love
for everything pertaining to Linux.
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You have seen many TUX stickers on the Web, but I am
sure you've never seen anything like this before.

The best part is yet to come—you can have these stickers
for free!

All you have to do is run to the post office and send a
postage-paid, self-addressed envelope to:
TUX Magazine
PO Box 3587
Houston, TX 77253-3587

For additional information about sending postage-paid envelopes internationally,
please refer to our FAQ: http://www.tuxmagazine.com/xstatic/aboutus/FAQ.html#Stamps
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Until recently, home musicians wanting to make
music demos generally had to fall back on the
dodgy-tape-recorder-with-a-mic-in-the-living-room
approach. Those who were a bit more serious
would buy several microphones and a small mixer,
or even a four-track recorder. Thankfully, these
cheap and nasty methods (with frankly uninspiring
results) are no longer necessary with free software
like Audacity, which allows musicians to create
songs with multiple audio layers, stereo effects
and much more. Plus, it’s just as cheap as
those other methods ever were—and not even
half as nasty.

INSTALLATION
Audacity is in most distribution repositories, in the
main Debian archive and in (K)Ubuntu’s reposito-
ries. To install via Synaptic, simply scroll through
the list of packages to the audacity entry; other-
wise, look under Sound. If it has a green square
next to it, it’s already installed. If not, right-click
on the package name, and left-click on Mark for
Installation. Then click Apply, follow the prompts
and close Synaptic. Audacity usually can be found
in your menu under Multimedia or Sound. If not,
scout through your distribution’s menus, and if all
else fails, simply enter the command audacity on

the command line or in Run Command in the KDE
menu.

LAYERS
The essential advantage of Audacity is the abil-
ity to create layers, which is what we focus on
today. If you follow along, you’ll end up with
several layers of recorded sound waves, one
above the other, which all can be modified
individually. As my main example, I focus on
making a song, but don’t feel that Audacity is
limited to musicians. The uses of this nifty little
program are limited purely by your imagina-

tion. Enough techno-babble—let’s jump right in
with an easy demonstration.

RECORDING
The following instructions assume you have a
microphone and a pair of headphones. Make sure
that your microphone channel is unmuted in

Rich Multilayered Sound with Audacity
Explore the possibilities of layered audio and spruce up band demos!
JOHN KNIGHT
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Figure 1. Make sure Mic is chosen in this drop-
down box.

Figure 2. The Control Panel and its controls—note
the Close button at the top left.
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the mixer, and if it isn’t already chosen, choose
Mic from the pictured drop-down list. Say a
few test words to make sure it’s working, and
then do the following:

1. See those buttons for Play, Stop, Record and so
on? This is the Control Toolbar. Press the Record
button, and talk/sing/scream anything for a few
moments, and then press the Stop button. As
you’ll see, a track has just been recorded.

2. Press the Play button, and you should hear your
voice play back.

3. Press Record again, and fire off some more gib-
berish. You’ll notice your voice from before
pumping through while you speak; don’t get
put off, just keep talking for a bit more, and
then press Stop.

Now you have two recorded layers of sound.
Press Play, and you’ll hear both playing at the
same time. Record one more and read on.

MANIPULATION
So far, we have a fairly pointless jumble of
sounds, but let’s manipulate each of the layers so
we can make some cool effects.

Let’s go for the second track. If you look on
the left, the gray part is called the track’s Control
Panel, in which you’ll see a slider bar labeled L
and R. This is called Pan, and it controls the stereo
effect of each track. It is currently set to the cen-
ter. With the second track, set the Pan to 50%
left; set it 50% right on the third track, and leave
the first track in the center.

Now, press Play! Pretty cool, huh? Let’s play
some more. See the – and + signs above the Pan
slider? This controls Gain, which can either reduce
or amplify the volume of the track you’re on. Try
turning one track up a little and the others down
some. What about Mute and Solo? Mute turns
the sound off for one or more tracks, and Solo

plays one track by itself. These are some of the
very basics of sound engineering, but who
wants to show off recorded gibberish? Let’s
make something useful—a band demo. Those
voice tracks are going to be in the way though,
so either close the tracks by clicking the X in
the top-left corner of the tracks’ Control Panel,
or open a new project (File→New) and close
the current project (File→Close).

MAKING A BAND DEMO
Although this article is primarily aimed at musi-
cians wanting to make demos, if you’re purely
interested in layering sound for your own experi-
mentation, simply substitute the mentioned
instruments/vocals with whatever you want to use
at the time.

To avoid the usual low-fi pitfalls of band demos,
we’ll record one instrument at a time so that each
can be edited individually. The drums are the best
place to start. Before you do a proper take, check
the sound levels by having a quick bash on the kit,
recording it and closing the sound test afterward.
Once you’re satisfied with the sound, record a take
or three (see the Drum Tips and Multiple Takes
sidebars for more info), and export each track by
doing the following:

1. Click on the track’s Control Panel, which high-
lights the whole track.

2. Under the File menu, choose Export Selection As
WAV, choose the directory you want to save it
under and the filename, then click OK.

For now, we’re using WAV instead of MP3 or
Ogg, because WAV does not lose any quality,
unlike compressed MP3/Ogg. It’s best to use
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Figure 4. Exporting the Recorded Tracks as WAV
Files

Figure 3. The Three Recorded Tracks
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MP3/Ogg only at the very end, and only after mak-
ing a master WAV.

Once you have a take that you’re happy with,
close any bad drum tracks and import your best
take. This is easily done. Either choose Project→
Import Audio from the main menu, or simply drag
and drop the file from your file manager onto the
Audacity screen.

With the drums finished, let’s move to other
instruments. I’ll assume bass for this, but feel
free to record whatever you’d prefer. With your
drum track recorded and in place as the first
track on-screen, get ready to record. The usual
method is to have a microphone facing the
instrument’s amplifier; this is all an issue of taste,
so play around with a few positions and settings,
and record a few sound checks with the drums
muted. Once you’re happy with the sound of
what’s being recorded, unmute the drum track,
and slap on a pair of headphones.

Now, press record when you’re ready, and the
drum track will be playing through your head-
phones, and you will be playing bass over the top
into a new and separate track. As before, record a
few takes and then import the one you’re most
happy with. With the fundamental drums and
bass out of the way, record the other instruments
and vocals as you did with the bass. Don’t forget
to save each individual recording.

MIXING IT ALL TOGETHER
Now that the recording is out of the way, let’s
spruce things up. If you don’t have them on-
screen already, import all of the good takes of
each musician and do a basic mix. At first, every-
thing will be in the center and sound a bit off-kil-
ter with some layers standing out too much, or

others being too subdued. Use the Gain slider on
each track’s Control Panel to turn each track up or
down until everything fits in place. The basic mix
is out of the way, but it’s still boring and mono
with everything in the center. Let’s add stereo.

As with our first experiment, use each track’s
Control Panel to move its position around in the
stereo image. You may want to try bass and
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Recording several takes of each musician is a
good idea, because with later editing, you
can mix and match the best parts of each
take and make a mastered take with quality
results. You also can run sections of multiple
takes simultaneously to create a thickening
effect—this is common with vocal layers,
especially in pop records.

MULTIPLE TAKES

If you’re going to be recording drums and
have enough mics and a mixer, you’ll want to
record in stereo, using line-in instead of the
mic channel. The other instruments are best
left to mono and then shifted around in the
stereo image later. To switch between stereo
and mono recording, see the Preferences set-
tings in the File menu. In the Audio I/O tab, go
to the drop-down box called Channels in the
Recording section. Here you can choose at will
between 1 (Mono) and 2 (Stereo).

STEREO/MONO RECORDING?
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vocals in the center, with the drums a little off to
the side, and other instruments like guitars well
off to the left and right to give strength to the
basic elements and color to the instruments you
want to stand out. By now, the song should be
taking shape, and it’s worth saving.

If you look at options in the main File menu,
you’ll see Save Project and Save Project As. These
save as a file that only Audacity on your machine
can read, but it allows you to keep any current
work in progress, including the settings on each
track. Export As WAV (not to be confused with
Export Selection As WAV) saves the entire project
as it stands as a single WAV file that can be
played by anyone. Audacity will give a warning
about down-mixing to stereo—ignore that; it isn’t
a problem. If you want a smaller file to give to
your friends or put on the Net, try Export As
MP3/Ogg Vorbis, but only once you have a good
WAV master copy.

Now it’s up to you as far as where you want
to take it and how much more you want to
learn. It’s well worth learning how to do some
editing, how to add effects an so on, but 
we don’t have room to cover these today.
Experiment with all the different effects and
options in the menus, and download some 
of the plugins available on the Net. Audacity
isn’t limited purely to making band demos;
what you want to do with it is up to you. You
can play around with making straight vocal
harmonies, creating soundscapes with many
different layers of samples, making audio com-
mentaries over another piece of audio...it’s all

up to you. I look forward to seeing what you
come up with!�

John Knight is a 21-year-old, rock-climbing,
Japan-loving megalomaniac, trying to
take over the world from his bedroom
via his keyboard. He spends most of his
time tinkering with MPlayer and head-
banging to his MP3s.
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Audacity Home Page:
http://audacity.sourceforge.net

Plugins: http://audacity.sourceforge.net/
download/plugins

RESOURCES

Figure 5. The Satisfying Results of the Final Mix

Figure 6. Recording a Guitar Track Using Audacity

Drums are the hardest part of recording, with
entire books dedicated to the subject. The
dilemma is that you cannot play with the
other musicians or the sound will bleed
through the mics. You may want either to play
to a metronome or pre-program the drums in
something like Hydrogen and save it as a .wav
file that can be imported.

DRUM TIPS
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I hate bookkeeping, and I expect I am not alone. I tend to pile up paperwork
related to bookkeeping and always find an excuse not to get around 
to doing it. So, with much resistance, I finally decided to take a look 
at KMyMoney.

This article is more of a status report than a how-to. I quickly realized
that bookkeeping is bookkeeping, and telling you to use the Add
Institution menu item to add a bank was not going to be particularly
useful. That is, the program is well organized, and you just need to sit
down and start entering information. And, when you have a question,
the on-line help is there for you.

What KMyMoney is not is a program to run a business. The documenta-
tion suggests that it could be extended through plugins to support that kind
of work, but the stock program does not include the sorts of documents you
need (invoices and purchase orders) for a business.

If, however, your needs are personal finance, you probably will find what
you need. For example, stock investments are handled very cleanly. However,
on the not-ready list here are stock splits, derivatives and tax reporting.

On the other hand, reconciling a bank statement with what is in the sys-
tem or producing a net-worth report to show a lending institution is usually
more important for most of us.

The program will likely appear in the Office sub-menu of your K menu.
Note that if you elect to start KMyMoney from the run box (press Alt-F2), the
actual program name to type is kmymoney2.

On startup, you will see a screen like the one shown in Figure 1. In the
Set Up menu, you are asked for personalization information, including your

base currency and an account template to use with many language choices.
I was surprised to see the Nicaraguan Cordoba in the list of currencies.

This actually led me to try an account in a different currency, which brings
good news and bad news. The bad news is that the default version on
Dapper Drake (0.8.2) crashed when I tried doing this. But, there are two

Managing Finances with KMyMoney
Making bookkeeping less painful.
PHIL HUGHES

SUITED UP

Figure 1. KMyMoney Startup Screen
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pieces of good news. The first is that this problem
appears to be fixed in version 0.8.4, and even
more important, this feature goes beyond what
I expected.

I expected that I’d be able to put in amounts in
various currencies, but that I’d then have to tell
the program the conversion rate. Although this is
an option, once you have added the currency to
your list, as shown in Figure 2, clicking the Update
All button makes KMyMoney go to the Internet
and get the current conversion rate. This also
works for stock prices.

Once you get the basics set up, a good next
step is to add institutions and accounts. Although
only a name is required for an institution, you can
add other useful information, such as routing
code and contact name.

When you’ve entered all your banking informa-
tion, you can add Payees. For example, you proba-

bly write an assortment of checks regularly for
utilities and possibly a house payment. These can
be entered as Payees. Direct debit is one payment
method, so if your house payment, for example,
is deducted automatically, you simply specify
this. In addition, you can establish the due date,
and KMyMoney automatically enters these direct
debit transactions.

There are quite a few default reports (Figure 3)
and others that can be customized. The reports
display on-screen with the option to print them. In
addition, you can export them as either HTML or
CSV to import into other programs or copy them
to the clipboard, so you can paste them into
another program.

Customizing reports is not a programming
task. You start with a base report and through
the Report Configuration menu, you can define
exactly what you want on a report.

KMyMoney is still in active development, and
some features aren’t included yet. For example,
charts and graphs fall in that category. But, all in
all, the program seems very complete as far as
being functional; it is well designed and extensi-
ble. For example, the documentation explains that
additional import plugins can be written and
points you in the right direction to do that.

Compatibility is always an issue with new soft-
ware. I have a credit union account that allows
me to export transactions in either Excel or
Quicken (QIF) format. Well, KMyMoney can
import QIF files. In addition, it can export in QIF
format and supports QFX and AqBanking formats
(whatever they are) for importing.

My conclusion is that if you hate bookkeeping
but realize you have to do it to keep your personal
finances under control, KMyMoney is the best
choice I have seen. In addition, although it is not
designed to run a business, if all you need is a
program to keep track of your bank accounts
and pay the bills—something that is common
for people who run a Web business where all
the transactions are handled through a shopping
cart system—KMyMoney will serve you well.�

Phil Hughes is Group Publisher for SSC
Media Corp.
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Figure 2. Currency Conversion Figure 3. Default Reports

WHAT KMYMONEY IS NOT
IS A PROGRAM TO RUN 
A BUSINESS.
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Project management is a lot like accounting. Most
of us hate to do it, but we also realize it is neces-
sary. At least for me, the trick is to find a tool that
allows me to do the work with a minimum
amount of pain.

In my search for project planning software, I
looked at a lot of options. Being a geek at heart,
the best choice for me personally (Task Juggler)
isn’t likely to be a win for most TUX readers.

So, I settled on Planner. Planner is a GNOME-
based program that, like The GIMP, runs just fine
in KDE. This means it will look a bit different from
programs developed specifically for KDE, but func-
tionally, it will be the same.

Let me say up front that Planner is not the be-
all and end-all to project planning. I find it ade-
quate for a project where I just need to produce a
time line and show dependencies and resource
usage. But, if you need a full-blown system, you
should look at the various Web-based applications
available. DotProject and PhProjekt are two that I
have used in the past.

When I installed Planner using Adept, it magi-
cally appeared as Project Management in the
Office menu. In any case, typing planner in the
Run Box (press Alt-F2) should get it going as well.
Figure 1 shows what it looks like when it starts.

The left part of the main window offers but-

tons to select the Gantt Chart, Tasks, Resources
and Resource Usage views. The top has short-cut
icons as well as the typical pull-down menus.

There is nothing magic about entering infor-
mation here. A project can have any number of
subprojects and any number of levels of subpro-
jects. One design decision was a minor irritation
but nothing fatal. To add a new task or resource,
you select insert and a default entry is inserted.
You then edit it (right-click) to put what you
want into it.

The one simple thing the program does not
do is resource allocation. That is, if I assign

100% of a resource to two different tasks, it
happily accepts that and shows that they can
be done at the same time. It does correctly
handle less than 100% allocation within the
task, so if you assign 50% of a resource, the
duration will be twice the work.

Project Management with Planner
Never miss a deadline again.
PHIL HUGHES

Figure 1. Starting Planner

Figure 2. Sample Task List

I FIND IT ADEQUATE FOR A
PROJECT WHERE I JUST NEED
TO PRODUCE A TIME LINE AND
SHOW DEPENDENCIES AND
RESOURCE USAGE.
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The typical way to avoid this problem is to make one task
depend on the completion of another that uses the same
resource. I don’t like this, but it also seems quite common.

Figure 2 shows the task list for a small project—writing this
article. Figure 3 shows the resulting Gantt Chart. The only thing
that is less than obvious is the [50] on the last line labeled with
fyl. That is where I allocated 50% of my time rather than 100%
to the task. You can see that while the work is only one hour,
two elapsed hours exist in the schedule.

There is a bit more you can do with resources. You can
set the hours available and costs of resources. The Resource
Usage display, as shown in Figure 4, allows you to see how
those resources are used. The green part of the bars is time
not being used. This is a bit misleading as unavailable time
and unallocated time both seem to be green. But, the num-
bers add up. You can have different work times for different
people, and you can assign costs.

And, that pretty much covers what Planner will do for you
today. It seems like a good tool for many tasks, and it is clearly
designed in such a way that new features can be added at
some point.�

Phil Hughes is Group Publisher for SSC Media Corp.
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Figure 3. Sample Gantt Chart

Figure 4. Resource Usage Display

A PROJECT CAN HAVE ANY NUMBER 
OF SUBPROJECTS AND ANY NUMBER
OF LEVELS OF SUBPROJECTS.
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Linux systems include a program called a package
manager, which you use to install new software as
well as update and remove software. Various
Linux systems offer different programs, but each
program offers basically the same capabilities.

For this article, we use the Kubuntu Dapper
Drake version of Linux. Although virtually all the
programs documented in TUX are available for
other distributions, in an effort to make things
“just work”, we are documenting Adept, the
package manager used with this distribution. If
you are using a different distribution, you will
likely have a different package manager. The
concepts are the same, but the appearance will
be different.

WHERE DOES THE SOFTWARE COME FROM?
The CD or DVD you used to install your system is
one source, but most additional software comes
from sites on the Internet called repositories. By
default, the Adept repository list is limited to the
primary Kubuntu repository, plus some repositories
containing security updates.

If you do not add any software to your system,
you still should run Adept occasionally to fetch
security and other updates. Kubuntu automatically
starts a program that monitors these repositories

Managing Software with Adept
Install new software easily and fetch security updates with Adept.
PHIL HUGHES

Figure 1. Starting Adept

Figure 2. Adept prompts for your password.

Figure 3. Adept When It First Loads
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for you. When updates are available, it displays a
red triangle on your panel. Clicking on the trian-
gle starts Adept Updater.

RUNNING ADEPT
To run Adept, start it from the System sub-menu
(Figure 1), or press Alt-F2 and type adept in the
Run Box. Enter your password when prompted
(Figure 2), and Adept starts.

Figure 3 shows what Adept looks like when it
first loads. Note that at the bottom of the win-
dow it lists the number of installed packages (937)
and the number available (4403). Also note that it
says 84 packages are upgradable. This is with the
default repositories.

First, I do the upgrades, which simply means
clicking on Full Upgrade and then clicking on
Apply Changes. This gives me the download
size (177MB), which is a lot but worth doing
for me. The system is still usable while the
download is happening.

Next, I configure additional repositories by
going to Manage Repositories in the Adept
(upper-left) menu. This brings up a new win-
dow showing the repository list (Figure 4).
Within this list are the other standard Kubuntu
repositories, but they are commented out and
displayed in grey.

To activate them, click on each one, then right-
click and select Enable. While you are in this
screen, take a look at the bottom where there is a
box labeled New Repository and an Add button.
You use this feature if you have to add an addi-
tional source for software. We won’t do anything
here now, but should you see instructions that tell
you to add a repository for a particular program,
this is where you add it.

For now, simply click Apply and then Close to
return to the main Adept screen. Then, in the
main screen, click Fetch Updates to update your
list of packages available from the repository.
Once the updated list is fetched, you likely will see
about 19,000 packages available instead of about
4,400. In other words, although you have less
than 1,000 software packages on your system,
you can select any of these additional packages
and install them with no more work than a few
mouse clicks.

ADDING PACKAGES
Now that you’ve updated your repository list, let’s
try adding some software. This is TUX, so I
entered tux in the search box to see what would
match and ended up with the list shown in Figure
5. I know about tuxtype, so I decide to load it.
You do this by right-clicking on the line in the list
and selecting Request install. For good measure, I
toss in tuxmath. The page is updated to show
how many packages will be installed (seven) and
how much software will be downloaded (6MB).
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Why seven? Adept automatically figured out what other packages were
needed to support tuxtype and tuxpaint. That’s it. I click Apply Changes, and
the system is updated, adding these new programs. The update includes
adding them to the K menu. In this case, I didn’t even have a games sub-
menu, so it was added automatically, and the programs appeared in the
menu (Figure 6).

That’s about all there is to using Adept. It will do a lot more as far as
offering you search options, details of packages and such, but you can learn
all that easily by playing with it. Now you are ready to make Linux do what
you want. Good luck.�

Phil Hughes is Group Publisher for SSC Media Corp.
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Figure 5. Searching for tux Software

Figure 6. Adept adds the new software to the K menu.
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Konqueror, KDE’s default file manager and browser, is a good all-around
tool, but that doesn’t necessarily mean it fits all your file management needs.
Sometimes a dedicated file manager can be a better choice for daily comput-
ing. Krusader is a powerful and versatile file manager that can make your
work more efficient and productive. Krusader is available with most KDE-
based major Linux distributions, including Kubuntu (and Ubuntu with KDE),
PCLinuxOS, KANOTIX and so on, and you can install the tool easily using
your distro’s package manager.

CONFIGURING KRUSADER
When you launch Krusader the first time, it runs the Krusader configuration
wizard. This does one simple but rather important thing: it locates helper
utilities that Krusader uses for added functionality. Once Krusader has
scanned your system, it shows an overview of installed and missing utilities.
Although you simply can skip the provided recommendations, it’s worth
spending time on installing the missing components. Take a closer look at
the missing utilities, and use the package manager to install them (on my
laptop, for example, I had to install Krename, Kompare and Kget).

Once the wizard has scanned your system, it opens the Konfigurator win-
dow, where you can tweak Krusader’s settings. First, you have to add paths
to the installed helper utilities. Click on the Dependencies icon, and enter the
paths into their respective fields. Enter, for example, /usr/bin/kompare into
the Kompare field and /usr/bin/kget into the Kget field. Another thing you
might want to configure is the startup directories. For example, usually you’d
want Krusader to display your home directory in the left panel and some
other directory in the right panel. To do this, click on the Startup icon, select
the Start with following settings option and enter the desired paths into the
Homepage fields. Alternatively, select the Save settings on exit option, and

Krusader will always open the last-used directories on startup. When you are
satisfied with the settings, press the Close button, and you should see
Krusader in all its glory.

KRUSADER: THE BASICS
If you’ve ever tried to work with a twin-panel file manager, you’ll feel at
home in Krusader. And, even if you are new to it, you should be able to
figure out most of Krusader’s basic features. You can copy and move files
from one panel to another, and you can move around directories using

File Juggling with Krusader
When Konqueror just isn’t enough.
DMITRI POPOV

Figure 1. Konfigurator allows you to tweak Krusader’s settings.
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the navigation buttons at the top. The function
buttons at the bottom allow you to perform the
most common file operations with a single key
press. Using context menus, you can perform
different actions on files and directories—for
example, right-click on a file, and you can see
its preview, open it with a specified application
and manipulate it in a number of ways. In other
words, you don’t even have to read the manual
to master Krusader’s basics. But, if you want to
unleash its full potential and call yourself a
Krusader power user, read on.

MORE-ADVANCED FEATURES
One of the smartest features in Firefox (or any
modern browser for that matter) is tabs; using
them you can manage multiple Web pages in a
single browser window. Although Krusader is not
a browser, its Tabs feature is equally useful and
efficient. Using it, you can open multiple windows
in the same panel and switch between them by
clicking on their tabs. This feature can come in
handy in many situations. Let’s say you need to

copy files from different locations into one direc-
tory. Simply open the source directories in sepa-
rate tabs in the left panel and the target directory
in the right panel. Then, use the tabs to switch
between the source locations, and copy files from
them into the target directory.

Krusader includes two nifty tools that make

navigation through directories faster and more
efficient. The first one is the History button; click
on it, and you will see a list of all previously visited
locations. Select a destination from the list to
jump to it.

Another useful tool is the bookmark manager
(BookMan), and as the name suggests, it allows
you to add bookmarks to locations. Using
Bookmarks is easy. To bookmark, for example,
the currently opened directory, press the
Bookmark button and select Bookmark Current.
BookMan also keeps a list of often-visited loca-
tions, so you don’t even have to bookmark the
most popular directories. To keep tabs on your
bookmarks, use the Bookmark Editor, which
allows you to add and edit bookmarks as well
as group them into folders.

Krusader truly excels when it comes to dealing
with multiple files: the file manager offers several
indispensable tools that help you manage hun-
dreds of files easily. Say you have a music folder
containing several hundred .ogg and .mp3 files,
and you want to select all .mp3 files and move
them into a separate folder. Using Krusader, you
can create a filter that selects only the files that
match the specified criteria. To do this, press the
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Figure 2. Krusader’s main window is divided into
two panels.

Figure 3. Using tabs, you can manage multiple
directories in the same panel.

Figure 4. Using History, you quickly can jump to
previously visited directories.
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select files using the filter button and specify the
filter. Because you want to select all MP3 files,
type .mp3 into the Enter a selection field. Press
OK, and Krusader selects all files with the .mp3
extension. Better yet, you can save the specified

filter by pressing the Add button, so you can
select the desired filter from the list when needed.

Need to rename several files at once? No
problem. Select the files you want to rename,
and choose File→Multi Rename. This starts the
Krename tool that guides you through the
renaming process.

Quick tip: one thing that might confuse you in
the beginning is how Krusader manages remov-
able media, such as a USB stick or CD. Normally,
when you connect a USB stick, it appears on the
desktop. But, to access it via Krusader, you have to
navigate to the /media directory. Here you should
see and access all your removable storage devices.

Krusader also offers a nifty feature that can
chop a file into smaller pieces, which can come
in handy when you need to send a large file via
e-mail or burn a huge backup file on several
CDs. Select the file you want to chop, choose
File→Split File, specify the size of each chunk
and press Split. Of course, Krusader also allows
you to assemble chopped files into one
(File→Combine Files).

Krusader also can deal with files stored in
remote locations, and it can access files via FTP
(and its secure version SFTP), FISH (the protocol
used to access files on remote Linux machines),
and SMB (the protocol used to access files on
remote Windows machines). Simply press the
New Net Connection button, select the desired
protocol, enter the required login info, and you
can access the files as if they were on your
local hard disk.

Finally, let’s take a look at Krusader’s most
advanced and useful feature called Synchronizer.
As the name suggests, this feature allows you to
keep two directories in sync. This may not sound

like much, but Synchronizer offers a few advanced
functions that make it a rather powerful tool. You
can, for example, perform an asymmetric synchro-
nization that moves files only in one direction,
which effectively turns Synchronizer into a backup
tool. You also can specify a filter, so Synchronizer
syncs only specific files.

To synchronize two directories, select them
in the left and right panels and choose
Commands→Synchronize Directories (or press
Ctrl-Y). Pay particular attention to what directories
are set as target and source (you can swap the
target and source directories by clicking on the
Swap sides button in the lower-left corner of the
window). Press the Compare button to see a list
of synchronization actions for each file. Finally,
press the Synchronize button to sync the directo-
ries. If you plan to perform the specified synchro-
nization again, you can save it as a profile. To do
this, press the Profile button in the lower-left cor-
ner of the window, select Add new entry, and
give your profile a name. The next time you need
to synchronize the directories, simply choose the
created profile.

FINAL WORD
These are only a few of Krusader’s features, and
there is much more to it than meets the eye. If
you want to explore other aspects of this excellent
file manager, read the official documentation at
http://krusader.sourceforge.net/handbook.�

Dmitri Popov is a freelance writer whose
articles have appeared in Russian, British
and Danish computer magazines. His
articles cover open-source software,
Linux, Web applications and other
computer-related topics.
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Figure 5. Use Krename to rename multiple files in
one go.

Figure 6. Synchronizer is Krusader’s powerful
synchronization tool.
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With three desktop machines (Kubuntu, Win
XP and a testbed, which is currently running
ReactOS) and a laptop (Xubuntu) in use at
home, our IT is reaching small office propor-
tions, and like many small offices, we run into
file sharing problems. Peer-to-peer networking
is fine when all the machines are on, but
inevitably it happens that the file I want is on a
PC that isn’t running. Even worse, it might be
on my testbed machine that is currently in
pieces or undergoing yet another upgrade. So,
we need an always-on server that any of us
can access any time, but if it is always on, it
needs to be quiet, reliable and cheap to run.

These requirements rule out Pentium 4 (too
hot and power-hungry) and Windows (needs
rebooting too often). Fortunately, I just happen
to have a Pentium III of no great distinction
that sports a massive passive cooler, and I’m a
bit of a Linux enthusiast. Apart from stability,
Linux has several other advantages. It’s free. It
is almost totally virus-resistant, and it comes
with excellent fire-walling and security fea-
tures. And, it is easy to administer remotely, so
once it’s set up, the server doesn’t need its
own keyboard, mouse or screen, which saves
expense, space, power and heat.

THE CASE
I’m planning on hiding this server in the loft, so
frankly; what it looks like isn’t an issue, the prime
requirement of the case is that it is big and airy,
allowing good air flow with nothing more than

natural convection. Apart from choosing a big
one, there are couple of things you can do to
improve air flow. Remove any case fans if you’re
not actually using them, as they impede the flow
through the vents. Remove unnecessary drives;
they waste space and their cables impede air flow.
All you need is a hard disk for your OS and files
and a basic CD-ROM drive to load the OS.

Building a Home File Server
Setting up a file server doesn’t need to be complicated.
PHIL THANE

Figure 1. The Case

Figure 2. Strip out everything you don’t need.
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Remove unnecessary cables too, and tie up those
you cannot do without to keep them out of the
way. Remove surplus cards, as your file server will
not need sound, 3-D graphics, USB, FireWire, SCSI
or MIDI. On-board graphics or a small basic graph-
ics card is all you need. Remember, warm air is
less dense than cold and tends to rise, so make
sure there is an inlet at the bottom and an exit
near the top. And, if you do hide your server
away somewhere, don’t bury it in junk or put it in
a confined space; let the air get to it.

There are acoustic damping kits available for
PC cases that can kill a lot of noise from fans and
disks, but as this server will run fanless, it’s not
necessary and can diminish the transfer of heat
through the case. If the case is already padded
with the stuff, remove it.

THE PSU
The majority of PC power supplies have a fan
that blows warm air out the back of the case,
but there are fanless designs available and also
some semi-fanless designs that run quietly
most of the time but have a fan that kicks in
when a heavy load on the PSU causes things to
get warm. I’m using a 300W fanless FSP Zen
model bought second-hand, but many similar
models exist. By modern standards, 300W isn’t
much, but it’s plenty for a Pentium III with
basic graphics. Depending on your foraging
and bargaining skills, the PSU may well cost
more than the rest of the project put together,
but it’s worth it for silent running.

THE CPU
My Slot 1 Pentium III originally was used in a slim-
line IBM desktop machine. (Remember the type
you put under the monitor, not under the desk?)

It was fitted with a huge heatsink and had a plas-
tic duct from there to the PSU air intake so that
the PSU’s fan sucked air over the CPU. Some years
ago I re-housed it in a standard ATX mini-tower,
but of course, the duct was completely the wrong
shape, so I left it off and found the chip ran per-
fectly well without it. It’s not good practice for a
chip that’s working hard, but in this server, it’s
going to be idle most of the time. It will just keep
the OS and networking software ticking, and from
time to time will pass an instruction to a hard
disk—not exactly stressful.

Pentium III base units are available from various
on-line suppliers and local computer shops. If you
buy one with a conventional small heatsink and
fan, then around $10 US on eBay will get you a
replacement Slot 1 processor with a large heatsink
attached. You might even be able to sell the other
one or keep it as a spare.

THE MOTHERBOARD
If you go the economy route, buying an old
base unit, the board that is fitted will be fine.
If you buy one separately, don’t get hung up
on specs; performance is not really an issue.
Having onboard graphics is useful. Fancy 3-D
cards use more power and create more heat,
but a basic old AGP card will do too. A modern
Linux desktop distro needs about 512MB of
RAM to run a GUI and graphics applications
happily, but in this situation, it will manage
with much less, the only irritant being that the
actual installation process might be slow.

THE HARD DISKS
It’s unlikely that a Pentium III motherboard will
support SATA, but even an IDE drive will handle
data faster than your home network, so that’s
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not really a problem. I opted for a single 80GB
drive from good-old eBay. When it starts to fill
up, I’ll add another. If you can afford it, buy
more or a larger one. If you are really serious
about keeping the server quiet, you could
invest in flexible drive mounts that isolate the
drives from the case.

THE OPERATING SYSTEM
Linux, obviously. The version of Linux isn’t really
an issue; almost any would do. I used Kubuntu. I
chose it because KDE has built-in K Desktop shar-
ing based on VNC for remote administration. It is
a single CD download that’s easy to install.
Download the .iso file from Kubuntu’s Web site
(http://www.kubuntu.org), and burn it to CD-R or
-RW. Whichever CD burner software you use,
make sure you chose the option to burn an ISO
image file rather than the regular Data CD option.
If you don’t, you’ll have a very useful backup, but
it won’t boot!

Installing Kubuntu should be just a matter of
inserting the CD, rebooting and following the on-
screen instructions. However, older PCs, such as
the IBM used here, will not boot from CD. To get
around this you need Smart Boot Manager—a
very small file that boots from a floppy and then
lets you choose which disk to run from. Choose
CD-ROM, and you’re all set. Smart Boot Manager
has to be written as an image file, and rather like
making a bootable CD, simply copying the file to
a floppy doesn’t work. There are full instructions
for both Linux and Windows users on
http://linux.simple.be/tools/sbm, and a disk writing
utility for Windows that is very easy to use.
Incidentally, this is a useful disk to have for any OS
that refuses to boot. The only downside to this is

you need a floppy drive, so I put it back in and
then removed it once the OS was installed.

Connect your server to your network and
Internet router before you start. During instal-
lation, it will detect the connection and set it
up automatically. It will ask a few basic ques-
tions about your location, language and time
zone, but nothing taxing. Hostname can be
anything, but I use Server. The basic distro
includes some desktop software you won’t
really need, but just go along with the default
selection for now. Kubuntu will ask you to set
up a user during the installation. Something
like System Manager or Administrator is sensi-
ble; save your real name for when you set up a
normal user account later.

Once installation is complete, it is time to fire
up Adept. Debian-based distros use the Apt pack-
age management system, and Adept is the KDE
GUI that makes it easy to use even if you have an
aversion to command-line work and text editing.
Go to Start Menu→System→Adept. Browse the

list of installed apps, and mark things like media
players and graphics software for removal. If there
is anything you are not sure about, leave it. Click
Apply Changes to remove the selected apps. Now
you can click the Full Upgrade button to update
whatever is left. Finally, you need to install some
networking applications. Find the following in
Adept: samba and samba-common. Mark them
for installation and commit changes.

CONFIGURATION
All configuration paths start at the KDE Control
Center.

Unless you have a very unusual network
card, Kubuntu will detect it and set it up using
DHCP. This will work, but it makes remote
administration tricky, as you have no way of
knowing the server’s IP address. Go to Network
Settings, click Administrator Mode, and enter
your password. Select the interface, and click
Configure. Assuming your router is set up using
192.168.1.1, make the server 192.168.1.2. You
can continue to rely on DHCP for your other PCs.

Samba uses the Microsoft SMB protocol to
interact with Windows shares. It talks to
Samba on other Linux boxes too, making it the
perfect way to set up a mixed network. There
was a time when configuring Samba made
strong sysadmins weep. These days, for home
networking at least, it is very easy. Different
configurations suit different circumstances, but
for starters go to System Administration→Users
& Groups, and create a user for each person
likely to want to put work on the server.

Now, go to Internet & Network→Samba. In
the Base Settings dialog, set a workgroup name
(your hostname will be there already). Click the
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Figure 3. Change from DHCP to Fixed IP
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Shares tab, check that homes is already set (add
if necessary), then select it and click Edit. Check
Share all home directories (or don’t, and add
each one you do want to share manually). The

remaining tabs in this dialog can be used to
increase security, either for business use or 
perhaps to keep kids out of your files

Click OK on the Shares page to return to the
main Samba dialog, and click the Users tab. Select
your Samba users from the list, and click Add. Set
a password for each (and make sure you record
them somewhere and give them to the relevant
users) or don’t—it depends what you have on
your PC and who is able to access it. Click OK to
save your changes, and exit.

So far you have only “enabled” sharing. Now,
to set up shares, you need either to log in as
each user, or better still, run Konqueror as root.
Press Alt-F2 to bring up the Run dialog. Enter
konqueror, and click Options→Run as different
user. Choose root, and enter your password. In
Konqueror, browse to /home and right-click on a
folder. Go to Properties→Share→Configure File
Sharing→OK. Check Simple Sharing, and click
Add. Browse to find the folder in question 
and click OK. Select Share with Samba. Under
Samba Options, make the folder Writeable,
and under More Samba Options, set Public,
Browsable and Available. Return to /home, and
click the Reload button. The folder should now

have a hand symbol indicating that it is shared.
Repeat this with other folders.

As a final tweak on the folders, again 
running Konqueror as root, go to a folder’s
Properties→Permissions menu, and change
them to Group and Others can Read and Write.
Depending on who has access to your network,
you might want to rethink these.

There is no reason why folders have to have
people’s names. You could just as easily set up
and share Photos, Office or MP3.

Accessing the shared folders from a Windows 
PC is indistinguishable from accessing a normal
Windows share. From another Kubuntu box, go 
to System Menu→Remote Places→Samba Shares.
From any Linux box, run your file manager 
and enter the address of the server in the 
form smb://your.workgroup. To make life 
even easier, right-click on the KDE desktop,
select Create New→Link to Location, and 
enter the URL there, giving you an instant
Network Neighborhood experience.

REMOTE DESKTOP SHARING (RDC)
If the server is to run without a keyboard and
screen, and especially if it is to be hidden away
somewhere, remote administration is very useful.
And it’s not the least bit difficult to set up. KDE
has simple GUI tools for VNC. On the server, go to
Network & Internet→Desktop Sharing. Check
Allow uninvited connections, Announce service on
network and Allow uninvited connections to con-
trol desktop. But don’t check Confirm Uninvited
connections before connecting. It is good practice
to set a password at this point.

On the PC you want to use to access the serv-
er, run krdc (K Remote Desktop Connection), and
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Figure 5. Making a Connection

Figure 4. Setting Up Samba via the KDE Control
Center

Figure 6. Choose the Connection Speed
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enter the IP address of the server followed by
:0 (zero, not O). Click Connect, and the remote
desktop appears, giving you complete control
of the server.

To control the server from a Windows PC,
download and install TightVNC (it’s free from
SourceForge). Run TightVNC Viewer, and enter
the IP address of the server followed by :0.

CHECKING THE SERVER
Run the server in an accessible location for as long
as you can before you hide it away, and check that
it can run without a keyboard and mouse. You may
need to make changes in the BIOS to enable this.
Make sure you can reboot it by remote control.
It helps if you set an automatic login via System
Administration→Users & Groups→Convenience.�

Phil Thane lives in Wales (UK), has
been a teacher and worked for eight
years on tech-support (Windows-
based CAD/CAM systems for educa-
tional use). Phil started freelance writ-
ing 15 years ago and began using
Linux about three years ago as a

hobby. He is now a freelance writer/teacher/trainer.
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Figure 7. KDE Control Center via VNC on Windows XP

Figure 8. Shutting Down the Server by Remote
Control

Smart Boot Manager:
http://linux.simple.be/tools/sbm

Operating System: http://www.kubuntu.org

TightVNC: http://www.sourceforge.net

RESOURCES
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Qunu is a new system for getting and giving help on-line. It’s innovative
because unlike community forums, help is given and received in real time.
Unlike IRC (Internet Relay Chat), where there are many people talking about
a certain topic, Qunu uses a free, open-source instant messaging service
(XMPP/Jabber to be exact) to connect a person who seeks help with a person
who offers it.

The whole idea is that users who need help simply can search for a per-
son—an “expert”, using Qunu’s terminology—by keywords (such as Gentoo,
KDE, cooking and so forth). People looking for help also can simply type
their questions, and the system will present a list of suitable experts that are
currently available.

USERS? EXPERTS?
Are you a user or an expert? Well, it depends on what you want from Qunu.
As already mentioned, there are two roles you could take: the user who asks
or the expert who answers—although these two roles don’t necessary
exclude each other. Anyone (users or experts) can search for help—that is
why Qunu is there, after all. And, it is not even limited to computer-related
questions—you can ask for or offer help for any topic you can possibly think
of! Qunu works with the assumption that everyone is an expert of some
degree in at least something—regardless of whether it’s virtual servers, cook-
ing or literature.

OKAY, SO I HAVE THIS QUESTION...
If you want to ask a question using Qunu, you don’t need any special soft-
ware, simply a Java-enabled browser, which is compatible with the Qunu
home page/Web client. The system currently is tested to work with Firefox

and Opera (and IE), and according to the home page, it should work with
Konqueror and Safari shortly. The easiest way to begin is simply to go to
http://www.qunu.com, and type in your question (Figure 2). After a short

Get Real-Time Support Using Qunu
When forums and mailing lists are just not quick enough.
BY MATIJA SUKLJE

Figure 1. Qunu Main Page
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while, you will be presented with a list of
experts and tags (Figure 3). In the main part 
of the page, you will see the list of experts 
currently available with short descriptions of
them and the number of people they have
helped already. Clicking on their names shows
more information on their knowledge. If you
have already found someone you think is capa-
ble of helping you, simply click on the two 
chat bubbles on the right and wait for the chat
window to appear. If you need to broaden or
narrow your search, simply check and/or
uncheck the relevant tags on the right-hand
side of the page, and watch the list update
according to your specific needs until you are
completely happy. Another option is to click 
on the most relevant tag on the screen instead
of asking a question; however, I prefer asking a
question, because my problems usually involve
more than only one tag.

Once you have found a helper, the chat
interface pops up (Figure 4). This part probably
will be familiar. The conversation window
works like any other normal instant messenger
program. The toolbar at the top offers some
interesting features. If you click on Invite, you
can invite any other logged in Qunu users or
experts to join if you think they would benefit
from your conversation or be able to help you
better. Clicking Save opens a window of your
conversation in pure HTML that you can save
to disk, so you can have a look at it later.
Clicking Clear clears the window of text, and
under Options, you can turn on or off sounds
and emoticons.

Now that you understand the interface, you
can start the conversation with an expert. At
this stage, there are no Qunu-specific tricks
you need to know, but a few standard hints
are in order anyway:

� Be specific—try to explain the problem and
how it came to be in full detail, including what
you did, what happened and the output.

� Be polite—people don’t like being abused,
especially if they are volunteering their time!

� Be cooperative—this is only in your interest; no
one can help you if you are not willing to do
something to solve your own problem.

� Do not be afraid to admit mistakes—everyone
makes them.

After you quit your conversation with the
expert, you will be asked if you want to give feed-
back. Giving feedback is quite simple; there are
only two questions. Feedback provides other users
with an idea of the expert’s friendliness and quality
of answers (Figure 6). Ratings of individual experts
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Figure 2. Simply type in your question. Figure 4. Chat InterfaceFigure 3. Qunu presents available experts and
relevant tags.
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are listed next to their names—place the cursor
over each of the three circles for more information
about an expert.

BEING AN EXPERT
So you have arcane knowledge of Python, or you
know how to do fancy needlework and want to
help anyone in a jam? You are in the right spot
with Qunu then! You need at least a capable
browser, as stated above, but this is not always
practical for various reasons. First, being an
expert means you should be logged on the site
and have it open all the time so you are available
for help. Second, you most likely will miss a lot

of calls for help if you do not look at your
browser all of the time.

A better idea is to install IM (Instant
Messaging) software that supports the Jabber pro-
tocol, such as Kopete. Kopete is a nice KDE appli-
cation that can access several IM protocols at the
same time, including Jabber. You need to have at
least version 0.12.1 of Kopete to make it work
flawlessly. You can check whether you have an
older version of Kopete by selecting Help→About
Kopete in the Kopete window (Figure 7)

If you are using (K)Ubuntu and your Kopete
version is older than the required 0.12.1, you can
update it using the official dapper-backports

repository, which includes packages that are not
yet in Dapper but are stable enough to be there.
To do this, open Adept, and after typing in your
root password, select Adept→Manage
Repositories. When the new window opens, type
deb http://archive.ubuntu.com/ubuntu 
dapper-backports main restricted universe
multiverse, and click Add. After you have added
the new repository, click Apply and close the man-
ager window. Then, in the main Adept window,
click the Fetch Updates button. After the updating
finishes, type kopete in the quick filter/search box,
right-click on the kopete package that shows up,
and select Install from the pop-up menu. After
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Figure 5. Starting Your Conversation with an
Expert

Figure 7. Check the version in the About Kopete
window.

Figure 6. Giving Feedback about an Expert

QUNU WORKS WITH THE ASSUMPTION THAT EVERYONE IS AN EXPERT OF SOME DEGREE IN AT
LEAST SOMETHING—REGARDLESS OF WHETHER IT’S VIRTUAL SERVERS, COOKING OR LITERATURE.
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that, all you have to do is click the Commit Changes button and wait for
Kopete to install.

Now you have the client, but you also need a JID (Jabber ID) to connect
to Qunu. This is easy. Simply fire up Kopete, select Settings→Configure from
the menu, and click New in the Accounts tab (Figure 8). In the first step of
the wizard, select Jabber, and in the second, put in your JID details if you
already have a JID; otherwise, choose Register New Account, and fill in the
needed information (Figure 9). Here, it doesn’t matter which Jabber server
you choose—jabber.com seems to do it for me—you are free to chose any
other that might catch your fancy.

With the IM client set up to run Jabber, all you have to do now is register
to Qunu and add the Qunu service bot to your contacts list. You can register
your account by going to http://alpha.qunu.com, clicking Register and fol-
lowing the wizard—it’s easy. Now, add the service bot by selecting File→Add
Contact→your JID, and enter quser@qunu.com into the Jabber ID textbox
(Figure 10).

Once this is done, you are a registered expert on Qunu, but your profile is
still empty. To edit your profile, click on quser@qunu.com from your contacts
list, and you will be presented with a chat window with the service bot. The
bot is quite powerful—if you want to look for help, type help in the conver-
sation with the bot (Figure 11). You probably want to have a name, a short
description and some tags. To make a profile for a user named Wittytux, I
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Figure 8. Editing Your Accounts in Kopete

Figure 9. Registering a New Jabber ID in Kopete

Figure 10. Adding the Qunu Service to Kopete

PEOPLE LOOKING FOR HELP ALSO CAN SIMPLY
TYPE THEIR QUESTIONS, AND THE SYSTEM
WILL PRESENT A LIST OF SUITABLE EXPERTS
THAT ARE CURRENTLY AVAILABLE.
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type: profile name Wittytux. Being a
longtime Linux user, I type: profile
desc: I’ve been using Linux since
1993. And, being KDE- and Gentoo-savvy,
I type: tag KDE Gentoo Linux.

When you have your profile set up
as you want it (you always can tweak it
later), all you have to do is wait for a
user to click on you and ask for help.
When this happens, you are invited into
a new conference (Figure 12). In the
textbox, you can write in a nickname if
you like, but that invitation expires
within one minute. Then, it’s up to you
to decide how to help people, but
remember to be polite!

Qunu automatically takes you off the
available/on-line list when you are not
available on your IM client and puts you
back on when you are marked as on-line
in the client, so users do not try to con-
tact you when you are out for lunch. You
always can override this setting by telling
the Qunu service bot what your status is
with status on and status off. If you
want to know whether you are listed as
available at any given time, simply type
status without any further options.

IS THAT ALL?
Qunu is still in heavy development and aims to
be a massive help system with very broad top-
ics. Its future battle plans for world domination
include localisation—translation into several
languages is already taking place openly on-
line. Qunu also already is negotiating with
some helpline and IT companies to move some
of their helplines to Qunu—taking them from
the phone and onto your computer, where they
are closer to the actual problem. Additionally,
Qunu is planning to give experts the option of
offering their advice for a small price paid by
the user asking for help. Users needing high-
level expertise in a flash probably would be
willing to pay for extra-quick, high-end expert
help, although there would still be plenty of
experts providing help for free.�

Matija Suklje is a 21-year-old law stu-
dent and member of Cyberpipe from
Ljubljana, Slovenia, who has been
interested in Linux and F(L)OSS since
his early high-school days when he
first met with Slackware. Currently, 
his favourite distribution is Gentoo.

You can contact him via e-mail at matija.suklje@rutka.net
or look for more contact info on his home page 
(http://matija.suklje.name).
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Figure 11. Asking the quser Bot for Help

Figure 12. Conference Invitation from a User

SO YOU HAVE ARCANE KNOWLEDGE OF PYTHON, OR 
YOU KNOW HOW TO DO FANCY NEEDLEWORK AND 
WANT TO HELP ANYONE IN A JAM? YOU ARE IN THE
RIGHT SPOT WITH QUNU THEN!
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Quake 4 was produced by Raven Software using the Doom 3 software from
id Software and is distributed through Activision. Due to violence, Quake 4
carries an ESRB rating of Mature and isn’t recommended for anyone younger
than 17.

In Quake 4, you are Corporal Matthew Kane, a Marine taking part in a
large invasion dropped on to the Strogg alien home world, with the goal of
stopping further Strogg invasions of Earth. This is a first-person shooter (FPS)
game where what you see is what Corporal Kane would see looking through
his helmet. The game starts with a short animation where you hear a sum-
mary of the events in Quake 2, see your unit’s landing go wrong and from
there join in the battle with other survivors of the landing. Unlike most FPS
games, where you basically can assume anything moving is a target, in this
game you are often working with a small team of other Marines, and their
help is key to keeping you alive.

INSTALLATION
As noted in the System Requirements sidebar, Quake 4 has stiff hardware
demands. Having a good 3-D graphics video card is key to this game.
Although ATI has made strides with its Linux video card drivers, video
cards based on the NVIDIA chips seem to be Linux gamers’ preferred
choice. Further, you should look at cards based on the NVIDIA 6200
chipset or better.

If this sounds good, and your computer can support Quake 4, the ques-
tion is how to install it. Purchase a copy of Quake 4 for Microsoft Windows
2000/XP. There are two versions of the game: one includes a single DVD, the

other includes four CD-ROMs. The CD-ROMs or DVD have the data files
needed for the Linux version of the game. In the package, there is a manual
that is vital. It has a security code on the back cover, and the documentation
is useful, as once it starts, all versions of the game play the same way.
Beyond the retail package, you need to download a copy of the Quake 4
software for Linux. At the time of this writing, the latest version of the soft-
ware is quake4-linux-1.3-2.x86.run and can be found via id Software’s Linux

Quake 4
Introducing another great game for Linux.

COLIN MCGREGOR

Figure 1. The invasion of the Strogg home world begins.

DIVERSIONS

HAVING A GOOD 3-D GRAPHICS 
VIDEO CARD IS KEY TO THIS GAME.
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Web site (http://zerowing.idsoftware.com). The
install program is around 228MB, so dial-up
users beware!

Using the Konqueror file manager in superuser
mode, execute quake4-linux-1.3-2.x86.run. At
this point, the install program will ask you a series
of questions. You will need to agree to the condi-
tions, and the default file location values should
be fine. Don’t try to run Quake 4 yet; you need to
install the data files.

Copy over all the files that are in the
Setup/Data/q4base directory on the CD-ROM or
DVD that don’t exist in /usr/local/games/quake4/
q4base. There were problems with some files
originally released with Quake 4; you want to
keep the corrected files included with the
install program. Whenever Konqueror asks if
you want to replace a file, the answer is Skip.
If you have the CD-ROM version of the game,

you will have to change disks and repeat the
above process with each CD-ROM.

All the files in /usr/local/games/quake4/q4base
need to have their permissions changed so that all
the files can be read by Others. In Konqueror,
highlight the files, right-click, select Properties,
click Permissions, make sure Others is set to Can
Read, and then click OK.

The first time you start the game, you will be
asked to enter the security code combination of
letters and numbers found on the manual’s back
cover. Then, a few moments later the game
begins.

PLAYING QUAKE 4
At the beginning, you will be asked how hard you
want the game to be, and unless you are an expe-
rienced gamer with excellent reflexes, I suggest
you choose Private as opposed to the other levels,

which go up to General.
Quake 4 includes a multiplayer option that

lets you play against other Quake 4 users on a
LAN or on the Internet. There are several varia-
tions on the multiplayer game. In Deathmatch,
you try to make more kills than anyone else in
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Figure 2. Operating the Machine Gun on a Hover
Truck

Figure 3. A Shootout with a Strogg Soldier Figure 4. Seeing Some of the Other Marines

TO KEEP THINGS INTERESTING,
IN MOST OF THE MULTIPLAYER
GAMES, A KILLED PLAYER CAN
RETURN TO THE GAME WITHIN
A FEW SECONDS, BUT WITHOUT
ANYTHING THE PLAYER PICKED
UP DURING THE GAME.

http://zerowing.idsoftware.com
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a certain amount of time. In Team Deathmatch,
your team tries to make the most kills in a cer-
tain amount of time. In Tournament, you battle
another player one on one. Finally, in Capture
the Flag, players are divided into two teams.
Each team must get the other side’s flag and
return it to its own base. To keep things inter-
esting, in most of the multiplayer games, 
a killed player can return to the game within 
a few seconds, but without anything the player
picked up during the game.

SUMMARY
In summary, Quake 4 has eye-popping graphics,

stiff hardware demands and a complex install
program. In single-player mode, I found the
levels felt a bit too heavily scripted—too prede-
termined. Still, it’s great fun. In multiplayer
mode with a fast Internet connection, expect
to have a blast.�

Colin McGregor works for a Toronto
area charity, does consulting on the side
and has served as President of the
Toronto Free-Net. He also is secretary for
the Greater Toronto Area Linux User
Group meetings and is the moderator
for the Unix Unanimous user group.

DIVERSIONS

53www.tuxmagazine.com

Figure 5. Playing Capture the Flag with the Strogg team leading 7 to 4 over the Marine team, and 11
minutes 24 seconds left on this level. An extra gun is visible just ahead.

� 2GHz Pentium 4 or Athlon XP 2000+ CPU

� 512MB of RAM

� 2.8GB free hard disk space

� CD-ROM or DVD-ROM drive

� 3-D graphics video card

� Soundcard with ALSA or OSS support

� Kernel 2.4, with 2.6 recommended

� Glibc 2.2.4 or later

� For multiplayer mode, a broadband 
connection is required for Internet play

SYSTEM REQUIREMENTS
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